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LIMITATION OF LIABILITY
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to proceed with the use of VERSAT-2D.

This product is licensed to Authorized User only
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Version 2021.06.09-sv
Copyright (c) 1998 - 2021

Limitation of Liability: Although the licensed product (software) has been tested extensively
by the publisher and experience would indicate it is accurate within the limits given by the
assumptions of the theory and data used, the publisher (Wutec Geotechnical International)
and the author (G. Wu) assume no liability whatsoever with respect to any use of VERSAT 2D
package or with respect to any damages or losses that may result from such use. Any use of
the software to solve problems is the sole responsibility of the user as to whether the output is
correct or correctly interpreted or the problem correctly modeled.

The terms and conditions in the limtation of liability outlined above must be
accepted to proceed with the use of the product.
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1.

INTRODUCTION

VERSAT-2D is a software package consisting of three computer programs, namely, VERSAT-
2D Processor (the Processor), VERSAT-S2D and VERSAT-D2D.

It is noted that these three components of VERSAT-2D function independently. Interactions
among them take place through data files saved in a Windows Explorer file folder. A brief
description for each program is provided below.

VERSAT-2D Processor (the Processor) is a Windows based graphic interface program. It
serves as a pre and post processor for VERSAT-S2D and VERSAT-D2D. The program is used
to generate a finite element mesh, define soil zones, assign material properties, define boundary
conditions, assign pressure loads, and generate input data for VERSAT-S2D & VERSAT-D2D.
The program can also display and plot results from analyses such as stresses, displacements,
accelerations, pore-water pressures, and a deformed mesh.

VERSAT-S2D is a computer program for static 2D plane-strain finite element analyses of
stresses, deformations, and soil-structure interactions. The static analyses can be conducted
using stress-strain constitutive relationships from linear elastic model to elastic perfectly plastic
models, i.e., Mohr-Coulomb model or Von-Mises model. The static loads are applied in a
drained condition; each load application is assumed to be acting in a long time to fully dissipate
any pore water pressures due to the load application. This program can also be used to compute
or determine static pre-existing stresses for use in a subsequent dynamic finite element analysis.
Main features of VERSAT-S2D are:

e Linear elastic model
e Von-Mises failure criterion for CLAY type
e Mohr-Coulomb failure criterion for CLAY, SILT and SAND types

e Stress level dependent stiffness (moduli G, B) that are strain-level independent prior to
failure

e External load applications

e Staged construction by adding Layers (each Layer is a load application; so is a Run)
e Staged excavation by removing Layers

e Pore water pressure application

e Calculation of stresses and deformations caused by strength-reduction of soils

e Simulation of sheet pile wall and anchors

e Updated Lagrangian analysis

e Factors of safety calculation
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e Gravity on and off

e Calculation of pre-existing stresses for use in a dynamic analysis using VERSAT-D2D
e 4-node, 6-node and 8-node solid elements to represent soils

e 2-node line elements to represent sheet pile walls (beam) or anchors (bar/truss)

e Use of any consistent units and sign conventions

VERSAT-D2D is a computer program for dynamic 2D plane-strain finite element analyses of
earth structures subjected to dynamic loads from earthquakes, machine vibration, waves or ice
actions. A dynamic analysis is always conducted in an undrained condition; dynamic loads
(such as an earthquake ground shaking) are assumed to be one load application acting in a short
time that does not dissipate any pore water pressures caused by the dynamic loads. The dynamic
analyses can be conducted using linear, or nonlinear, or nonlinear effective stress method of
analysis. The program can be used to study soil liquefaction, earthquake induced deformation
and dynamic soil-structure interaction such as pile-supported bridges. Main features of
VERSAT-D2D are:

e Application of horizontal, or horizontal and vertical, ground accelerations at a rigid base
e Application of horizontal outcropping ground velocities at a viscous/elastic base
e Application of a load-time-history at any nodal points
e Global force equilibrium enforced at all time
e Linear elastic model
e Stress level dependent stiffness (moduli G, B)
e Strain-level dependent shear modulus G
v Non-linear hyperbolic stress-strain model for SAND type and CLAY type
v Non-linear strain-softening model for SILT type
e Mohr-Coulomb failure criterion
e VERSAT-SAND Model for liquefaction analysis of sandy soils
e VERSAT-SILT Model for liquefaction analysis of silty soils (new since 2016)

e Effective Stress Method of analysis, including the effect of earthquake induced pore
water pressure on soil strength and on soil stiffness

e Calculation of ground deformations caused by soil liquefaction

e Calculation of factor of safety against soil liquefaction or strain-softening
e Simulation of sheet pile wall and anchors

e Updated Lagrangian analysis

e Gravity off for VERSAT-1D module

o Free-field stress boundary
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e 4-node solid elements to represent soils
e 2-node line elements to represent sheet pile walls (beam) or anchors (bar/truss)
e Use of any consistent units and sign conventions

e Probabilistic Seismic Performance Analysis (PSPA) including subduction Interface (e.g.,
Magnitude 9 or M9) and Non-Interface (e.g., M7) earthquakes (new since 2018)

e Local viscous damping (a, b) for stiff structures
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FLOW CHART TO ILLUSTRATE TYPICAL STEPS IN A DYNAMIC ANALYSIS:
Step 1:

VERSAT-2D Processor

e  Generate a finite element mesh (2D)

Define soil zones and material parameters

Define structural elements and parameters

Define boundary conditions, apply pressure loads
Generate input data for VERSAT-S2D or VERSAT-D2D

Step 2:

VERSAT-S2D (drained analysis)

e Conduct static stress analyses

e Conduct static deformation analyses
e Conduct static pore water pressure applications
e Conduct static soil-structure interaction analyses

e Determine pre-existing stresses

Step 3:

VERSAT-D2D (undrained analysis)

e  Conduct dynamic linear analyses with or without gravity

e Conduct dynamic nonlinear analyses of earth structures subjected to
dynamic loads from earthquakes, machine vibration, waves or ice actions

e Conduct dynamic nonlinear effective stresses analyses to determine soil
liquefaction (SAND & SILT) and earthquake induced deformations

e Conduct dynamic analyses of soil-structure interaction such as pile-
supported bridges

Step 4:

VERSAT-2D Processor

¢ View and print finite element mesh including node, element numbers

e View and print soil material zones (Color printer required)

e View and print results of stresses or displacements (peak and instant)

e View and print acceleration values (peak and instant), if applicable

e View and print analysis results of shear strains (peak and instant) or pore
water pressure or factor of safety against liquefaction

e View and print deformed mesh

e Save graphics as image files (.emf, or .qif, or .ipeg etc)

Woutec Geotechnical International, Canada (www.wutecgeo.com)
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2. PREPARING DATA FOR A NEW PROBLEM

2.1. Create a Setting File for Model Scale, Axis Scale and Others

1. The model scale (problem extent) and axis details (axis extent) are defined using ‘Set scale’
under SETTING. The Processor window only shows the part of a model within the X and Y
extent defined herein.

2. The defined model scale and axis details are saved using ‘Save Setting”’ under SETTING. A
setting file can be retrieved next time using ‘Load Setting’ under SETTING. A setting file
has a file type (extension) of log.

VERSAT-2D Set Scale

PROBLEM EXTENT
Minimum X Y [s0
Maximum X [15p Y |50
a2 LIt increment
Starts at increment e
AXIS-X |qp |20 |7
AXISY g |20 |6
MULTIPLIERS
X-multiplier Y-multiplier
[1.0 [1.0
CANCEL ‘ OK

3. In addition to the Problem Extent and Axis Extent, a setting file also saves the following:
a. Font size of text and numbers (node and element etc) shown on the model

b. Position, font size and content of all texts added through using ‘Draw ftext’ command
under TOOLS.

Note: Setting file is a text file. Therefore, all items in a setting file (font sizes, text
position, color ranges, etc) can be edited outside the Processor and then re-loaded into the
Processor to take effect.

4. The x-multiplier and y-multiplier is used to scale up or scale down a model by multiplying
the X and Y coordinates by x-multiplier and y-multiplier, respectively. For examples, the
multipliers can be used to convert the model between different units. Normally they are kept
as one.
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2.2. Create a Finite Element Mesh

The following commands may be used in creating a finite element mesh:

e Select ‘New’ under FILE to start a new problem.

e Use ‘Finite element node/grid points’ under DEFINE to pre-define the four nodes with their
exact X and Y coordinates.

e Choose ‘Draw finite element grid’ under TOOLS to create finite elements. Enter number of
elements for each grid side and press OK. Then click on screen for 1%, 2", 3" and 4™ nodes
that form the finite element grid.

e Use ‘Draw line’ under TOOLS to create a boundary within a finite element mesh. It is
required to organize the mesh after this modification.

e Choose ‘Cut/remove finite elements’ under TOOLS to remove finite elements that are not
needed. Then click on screen to select four points. The nodes and elements within a block
enclosed by the four points will be removed. It is required to organize the mesh after this
modification.

e To organize a modified mesh: choose ‘Clear duplicate nodes/elements’ under MODIFY,
then perform ‘Sort node(..)/element(..)’ under MODIFY. This process renumbers nodes and
elements of the model.

e If needed, use ‘Finite element node/grid points’ under DEFINE to change X and/or Y
coordinates of a node.

e If needed, use ‘move grid line’ under TOOLS to move a grid line within a finite element
mesh.

An example for creating a finite element mesh follows:

[Very important notes: During the course of mesh construction, it is recommended that data be
saved, using ‘Save Data’ under FILE, as frequently as possible. You may find it necessary to
save data, from various stages in a mesh construction, using different names such as conl, con2,
con3, cond, etc., because the Processor does not provide “undo” functions.]
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Step 1 Use ‘Finite element node/grid points’ under DEFINE to enter Node No. and (X, Y)
Coordinates of the four nodes (Note: NVARI, IX1, 1X2, 1X3 not required; they will be defined

by later)

This screen shot of the main Window is from:
VERSION 2019.05.08

(Some Windows in this User Manual are for an earlier version)

] VERSAT-2D STATIC AND DYNAMIC FINITE ELEMENT ANALYSIS OF CONTINUA

== X

File SETTING DEFINE TOOLS VIEW MODIFY RUN HELP

@ |7kl 2 e A | 5| ol ] w [ [0 I

(]

Note: NVARI, IX1, IX2, IX3 are for view only!

(null)

|2 (null)
(null)
(null)

Node Nu NVARI |X-coor |Y-coor |IX1 [1X2 |1X3
0 0 (null) (null) (null)
0 100 (null)  (null)  (null)
100 0 (null)  (null)  (null)
100 100 (null)  (null)  (null)

OK

Cancel

Step 2 Use ‘Draw finite element grid’ under TOOLS to create a 10x10 finite element grid

® VERSAT-2D STATIC AND DYNAMIC FINITE ELEMENT ANALYSIS OF €O... |- [O1[X]

)l e (3¢ 3 ol (M |

Draw Elements @ % 4

Element Distribution
side1 side?2

No. of element [1g 10|

El
material no h

OK ] Cancel

Woutec Geotechnical International, Canada (www.wutecgeo.com)
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Step 3 OK and then click on nodes 1, 3, 4 and 2 to create a 10x10 grid

m VERSAT-2D STATIC AND DYNAMIC FINITE ... [ [OX

File SETTING DEFINE TOOLS WIEW MODIFY RUN HELP

[0 e oA 13| | L [N/ P

5 |26 (37 [48 |59 (70 (81 |92 [103 [114 |425
14 |25 (36 (47 |58 (69 (80 |91 (102 113 |124
13 |24 (35 (46 |57 (68 [79 |90 (101 [112 |123
12 123 (34 (45 |56 (67 (78 |89 (100 111 |122
11 |22 (33 (44 |55 (66 [77 |88 (99 110 121
10 |21 (32 (43 |54 (65 (76 |87 (98 [109 120
20 |31 (42 [53 |64 (75 (86 |97 (108 [119
19 |30 (41 [52 |63 (74 [85 |96 (107 |118
18 |28 (40 (51 |62 (73 (84 |95 (106 [117
17 |28 (39 [50 |61 (72 (83 |94 (105 [116
16 27 38 49 60 71 82 93 104 M5

| | | | WO

12K nadac 1NN alamantfe) nacitinn v=-21 87K «:=11K R2N7R74Q42K7 QTATIM NN Prahl

Step 4 Use ‘Clear duplicate nodes/elements’ then Sort node(..)/element(..)’ under MODIFY to
re-organize the mesh

® VERSAT-2D STATIC AND DYNAMIC FINITE ... [ [O[X]

File SETTING DEFINE TOOLS VIEW MODIFY RUN HELP

[ s | T ore | ]3| | 1 L (1] P2

11 |22 |33 (44 [55 |66 [77 (88 (99 |110 [121
10 |21 |32 (43 (54 |65 (|76 (87 (98 |109 [120
9 20 (31 (42 |53 |64 |75 (86 (97 [108 [119
8 19 |30 |41 (52 |63 |74 (85 [96 |107 [118
7 18 |29 |40 (51 |62 |73 (84 (95 106 [117
6 17 |28 |39 (50 |61 |72 (83 (94 |105 [116
5 16 |27 |38 (49 |60 |71 (B2 (93 |104 |15
4 15 (26 (37 |48 |59 [70 (81 (92 [103 [114
3 14 |25 |36 (47 |58 |69 (80 (91 102 [113
2 13 |24 |35 (46 |57 |68 (79 (90 101 [112
1 12 23 34 45 &6 67 78 89 100 1M

Woutec Geotechnical International, Canada (www.wutecgeo.com)
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Step 5 Add more nodes using ‘Finite element node/grid points’ under DEFINE

T Ir=

N
NG

DEFINE

YIEW

IFY RN

All‘

F

"VERSAT-ZD STATIC AND DYNAMIC FINITE ELEMENT ... - [OX]

e e 36 4

L d

121

120
119

118
17

116

115
114

11 22 33 44 55 66 77 a8 99 110
10 21 32 43 54 65 76 a7 98 109
] 20 il 42 53 (64 75 a6 97 108
g 19 30 41 52 63 74 85 96 107
7 18 29 40 51 E2 73 a4 95 106
[ 17 28 39 50 61 72 a3 94 105
5 16 27 38 49 60 71 g2 93 104
4 15 26 37 48 59 70 a1 92 103
3 14 25 36 47 58 69 80 91 102
2 13 24 35 46 57 FSB 79 90 101
1 12 23 34 45 56 67 78 89 100
ist of Nodes

113
112
11

Node Numb NVARI | X-coor | Y-coor X1 [I1X2 [I1X3 -
115 2 100 40 0 0 0
116 2 100 50 0 0 0
117 2 100 60 0 0 0
118 2 100 70 0 0 0
119 2 100 80 0 0 0
120 2 100 90 0 0 0
121 2 100 100 0 0 0
122 (null) 120 0 (null) (null) (ul)
FE123 (null) 120 100 (null) (null) (ul)
t | ;IJ
OK | Cancel |

121 nodes 100 element(s) position x=10.2805049088359 y=123.62484157161 STATICON Problem

Woutec Geotechnical International, Canada (www.wutecgeo.com)
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Step 6 OK to show nodes 122 and 123

® VERSAT-2D STATIC AND DYNAMIC FINITE ELEMENT A...| - [O[X

File SETTING D

EFINE  TOOLS

MODIFY

RLIN

HELP

[0 v | o | A | 3] | 1 Ll w [ @] P

121

120

119
118
17

116

11 22 33 44 55 66 77 88 99 110
10 21 32 43 54 65 76 87 98 109
9 20 31 42 53 64 75 86 97 108
3 19 30 41 52 63 74 85 96 107
7 18 29 40 51 62 73 84 95 106
[ 17 28 39 50 61 72 33 94 105
5 16 27 38 49 60 7 92 93 104
4 15 26 37 48 59 70 81 92 103
3 14 25 36 47 58 [69 a0 91 102
2 13 24 35 46 57 68 79 90 101
1 12 23 34 45 56 67 78 89 100

115
114
113
112
111

123

122

File SETTING

DEFINE TGOLS

..IU‘I. I E ‘K\‘I l'JI‘

MODIFY

RUN

HELP

e o i 8L

Draw Elements EI
Element Distribution pe [f7 8  [a9 [110 1
side1 side?2 5 76 87 98 109 120
No. of element I4 hu 4 75 86 97 108 |19
3 74 85 96 107 118
2 73 84 95 106 117
ol 1 72 83 94 106 |16
ement

Tl i [1 po [71 [z [83  [104 |15
9 70 81 92 103|114
8 69 80 91 102 113

| OK I CanceIJ
7 68 79 a0 10 112
T Tr TS o L2 6 67 78 89 100 111

122

123

Woutec Geotechnical International, Canada (www.wutecgeo.com)
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Step 8 OK and then click on nodes 111,122, 123 and 121 to create a 4x10 grid

c, FINITE ELEMENT A...[]DD

DIWISWEIEIOFFINI/I%I st M@ |

11 22 33 44 55 66 77 88 99 110 [134149156167]128
10 21 32 43 54 65 76 87 98 109 |134144159166177
9 20 A 42 53 64 75 86 97 108 |139143154165176
g 19 30 4 52 63 74 85 96 107 [134143153164175
7 18 29 40 51 62 73 84 95 106 [13Q1411541634174
[4 17 28 39 50 [61 72 83 94 105 |126140151164173
5 16 27 38 49 60 71 82 93 104 |[12H139150161)172
4 15 26 37 43 59 70 81 92 103 |1231341491600171
3 14 25 36 47 58 69 80 91 102 |124137148159170
2 13 24 35 46 57 [58 79 90 101 |[124136147158169
1 12 23 34 45 56 67 78 a9 100 124135146157188

178 nndes 140 ol tfs) nositinon v=2 22531293463143 =115 394736842105 STATICON Prohlem Titl!

Step 9 Use ‘Clear duplicate nodes/elements’ then ‘Sort node(..)/element(..)’ under MODIFY to
re-organize the mesh

© VERSAT-2D STATIC AND DYNAMIC FINITE ELEMENT A...[. [O]X]
i C=ERINEY DEFINE TOOLS VIEW MODIFY RUN HELP

[ e o ]| ¢] | i | w (M1 @

1" 22 33 44 55 66 7 88 99 110 [121133143154165
10 21 32 43 54 65 76 a7 98 109 [120131144155164
9 20 31 42 53 64 75 86 97 108 |[119130141154163
8 19 30 41 52 [63 74 85 96 107 |11§129140151(162
7 18 29 40 51 62 73 84 95 106 |11791241391500161
6 17 28 39 50 [61 72 83 94 105 |116127139149160
5 16 27 38 49 60 71 82 93 104 [119126137148159
4 15 26 37 48 59 70 81 92 103 [114129136147|158
3 14 25 36 47 58 [69 a0 91 102 [113124139146157
2 13 24 35 46 57 63 79 90 101 [113123134145156
1 12 23 34 45 56 67 78 89 100 111122133144155

165 oodes 140 clement(s) nosition =19 2489563845619 w121 184210526316 STATICON Probler Titl

Note: Suggest saving the data as demol.sta

Woutec Geotechnical International, Canada (www.wutecgeo.com)
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Step 10 Choose ‘Draw line’ under TOOLS then click on Node 5 and Node 121

s VERSAT-2D STATIC AND DYNAMIC FINITE ELEMENT A... (2 [O[X]
EIEN SETTING DEFINE TOOLS VIEW MODIFY RUN  HELP

[ 9 o A€ | ca L w 1] |

T[22 |22 44 [55  [e6 17 88 [99 G dRypRd=121
0 |21 |32 |43 [64 |65 |76 [BL—{98 [109 [120131144159164
20 (31 42 [53 |64 75 [86  [97 (108 [11d1adi4qi5d163
19 (30 |81 52— |63 |74 [85 [86 [107 [1@12d914d151162
8 |29 [61 [62 |73 [84 [a5 [106 [117[12d139150161
28 [39  [50  [61  [72 [83  [94 [105 [11g12413d149160
desnapped=e |49 [s0 |11 [52  [a3  [104 [11g1z413714d159

D =~ ] O
N
3

4 15 26 37 48 59 70 81 92 103 [114129136147158
3 14 25 36 47 58 69 80 91 102 [1131241349146157
2 13 24 35 46 57 68 79 90 101 112123134149156
1 12 23 34 45 56 67 78 89 100 111122133144155
123 nodes | ition o = STATICON Prohler Tile |

Step 11 Choose ‘Cut/remove finite elements’ under TOOLS then click four points

File SETTING DEFINE TOOLS VIEW MODIFY RUN HELP

(129 sve [ o | A€ | cal L w 1)@ |

44 55 66 77 IBB ?94,”? QTQG%EW‘EQ@@d:’IZ'I
43 54 65 76 ﬁ?gg 108 [12dq131144153164
42 53 64 ] 97 108 |119130141154163
41 [a2—"163 74 85 96 107 |[118129140151162
:"UA?@_EZ 73 84 95 106 |117124139150161
39 50 61 72 83 94 105 |116127134149160
158 49 60 71 82 93 104 |[1151261379144159
37 48 59 70 81 92 103 |[11412913¢147158
36 47 58 69 80 91 102 |[113124139146157
35 46 57 (<] 79 90 101 |[1123123134144156

34 45 56 67 78 89 100 111122133144155

'
i
H
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Step 12 Use ‘Clear duplicate nodes/elements’ then ‘Sort node(..)/element(..)’ under MODIFY

© VERSAT-2D STATIC AND DYNAMIC FINITE ELEMENT A...[= [O[X]
File SETTING DEFINE TOOLS VIEW MODIFY RUN HELP

[0 sve v A [ € | ca L w (M1 P |

90 101113123134
- ]
P I S

ia 67 77 88 |99 (110121132
40 48 58 66 76 87 (98 [109120131
/’ﬁf_‘”gg 39 47 57 65 75 86 (97 [109119130
2) 23 30 38 46 56 64 74 85 |96 (107114129
17 22 29 37 45 55 63 73 84 (95 1106117128
16 21 28 36 44 54 62 72 83 [94 [109116127
15 20 2% 35 43 53 61 7 82 |93 (104119126
14 19 26 34 42 52 60 70 81 192 (104114125
13 18 25 33 41 51 59 69 80 91 102113124

e
11
10
9

8

7

6

=l M| W] &= O

node 12 and 50 causes large bandwidth

J.Z.é.nnd.es..l.l.ﬁ.e.l.e.me.um.n.ni SORTIMNG DOME! Max node difference 18 found in element 103 I!

Step 13 Use ‘Finite element node/grid points’ under DEFINE to adjust X and Y coordinates of
node 12 and node 50

= VERSAT-2D STATIC AND DYNAMIC FINITE ELEMENT A... [2 [O]X]
File SETTING DEFINE TOOLS VIEW MODIFY RUN HELP

(0] sve | T o | A |3 | 3 L w [ @ |

(a0 10113123134

_?:Egé;g 89 (100111124133
/5 67 77 88 (99 [110121132
40 48 58 66 76 87 198 (109120131

:: 3
{24 kil 39 47 57 65 75 86 (97 [109114130
1

23 30 38 46 56 64 74 85 |96 (107119129

12] 17 22 29 37 45 55 63 73 84 951106117128
9 16 21 28 36 44 54 62 72 83 (94 |109116127
g 15 20 27 35 43 53 61 71 82 [93 [104114126
v :
3

14 19 26 34 42 52 60 70 81 192 (104114125
13 18 25 33 41 51 59 69 80 91 102113124

=] M| W] &=

U34oodes 115 clement(e) nosition x=-12.1205963938974 42122 569593147762 STATICON Problem Titl

H
g
H
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Step 14 Perform ‘Clear duplicate nodes/elements’ then ‘Sort node(..)/element(..)” under
MODIFY

© VERSAT-2D STATIC AND DYNAMIC FINITE ELEMENT A... [= [O/X]
File SETTING DEFINE TOOLS VIEW MODIFY RUN HELP

[ e o A3 | 0 | w [0 @ P |

a0 [1oM113123134
74
"ﬁ:‘?g 89 1104111123133

B8
//t%m 77 (88 (99 [110121132

49
40 48 57 66 76 87 |98 (109120131

5443’? 39 47 56 65 75 86 |97 (109119130
§23 30 38 46 55 64 74 85 |96 (107119129
16 22 29 37 45 54 63 73 84 195 (106117128
15 21 28 36 44 53 62 72 83 (94 |109116127
14 20 27 35 43 52 61 7 82 193 (104119126
13 19 26 34 42 51 60 70 81 (92 [103114125
12 18 25 33 41 50 59 69 80 91 102113124

c)woocoéé\
o=

= M| W] &= O

normal bandwidth after adjustment

% SORTIMNG DOMNE! Max node difference 12 found in element 115 F

Notes:
e Suggest saving the data as demo2.sta

e The purpose of adjusting coordinates of node 12 and 50 (shown in Step 12) is to reduce
the band width of the model. This is done by relocating node 12 and node 50 so their X-
coordinates are equal to or greater than those of node 17 and node 58 (also shown in Step
12), respectively. The model after the node adjustment is shown in Step 14. This process
reduces the maximum node difference in the model from 18 to 12.

e This kind of node adjustment may reduce a problem size to half. As an example, a finite
element grid of 6000 elements (120 x 50) should have a band width of approximately 100
and a problem size of approximately 12,000,000. However, the problem size could be
doubled when the band width is 200 due to inadequate node numbering. As a result,
computing time in a dynamic time history analysis may be increased from 4 hours to 8
hours for one analysis.

H
g
H
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2.3. Set Boundary Conditions

Continue on the example:
Step 1: Choose ‘free all boundary’ under MODIFY

Step 2: Choose ‘assign boundary conditions’ under TOOLS to define boundary conditions. For
left boundary, click node 2 and 5. For the bottom, click node 1 and 124. For right
boundary, click node 125 and 134 and then assign boundary code as appropriate. All
nodes on the segment within the two points will be assigned to a specified boundary
condition.

File SETTING DEFINE TOOLS WIEW MODIFY RUN HELP

[l o 4] ~[3¢] s el [V P

120.224;100.09¢ Click on 2 Nodes to Assign Boundary Condition Within

To assign free disp-y (fixed disp-x) for nodes 125 to 134, type "1" in the input box

7} VERSAT-2D Input Box ([=8] % |
Elevation - Y (m) | boundary code=(0: xy free; 1:y free; 2: x free; 3: xy fixed; -1: ff; -2: x viscous J
700 OK Cancel |
0 o1 1112 1123 P3Node snapped=134
9
G0.0 K z g 9 |00 (111 122 [133
7 7 3 9 [M0 [121 132
40
70.0 40 ] 7 3 3 7 g [109 [120 [131
2
7 1 9 47 3 5 5 6 7 [108 [118 130
| <
500 3 0 3 76 5 4 % 5 6 [107 [118 [129
11
0 6 2 ] 7 15 1 3 3 I 5 [106 [117 [128
30.0 7 5 1 3 6 44 3 2 2 3 4 [105 [118 27
i 0 7 5 73 2 i T 2 3 [104 [115 [126
0.0 3 iE] 6 4 42 T 0 0 T Z 103 [114 M2Node snapped=125
T Tz Ta 5 3 ] 0 g g 0 T M0z T3 24
100 300 500 700 500 1100 130.0

Distance -X (m)

H
g
H
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Step 3: Choose ‘model view options’ under VIEW
e Check “show boundary condition”
e Check “Show x, y axis”
e Uncheck all others

e Click OK
i VERSAT-2D STATIC AND DYNAMIC FINITE ELEMENT AMALYSIS OF CONTINUA

File SETTING DEFINE TOOLS VIEW MODIFY RUN HELP

[0 sve 0 o | | 3¢ #* || w 1@ P ||

View Options @
VIEW MODEL OPTIONS VIEW VARIABLES OPTIONS
™ Show node numbers ™ Show deformed mesh
I” Show element numbers ™ Show by value and format=  |0.0
¥ Show X, y axis I Show variable by color
Elevation - Y (m) I~ Show material color : -
TG Value ranges for color
™ Show material number ,—
1 05
r -
Show layers by color |u 5 ’1—
 Show boundary conditions m h— Reverse color ™
900 =
™ Show water level ~
Select a variable
™ Show load vectors .
e Static output
I~ Show Color Legend at a o
70.0 P
=0 Y= [n r
- - s
-
Note: Due to conflicting, only one of the C .
following quantities is shown in Dynamic output
500 descending priority: 1). show layers by @] @]
color: 2). show deformed mesh: 3). show
material color. 4). show variable by color. '] 0.65
i .
300 OK CANCEL r r
0.0
|
100 300 500 700 900 1100

Distance -X (m)

Note: The boundary conditions of the model are shown above in red (solid circle = fixed/zero
displacement in X and Y directions; vertical line=free vertical displacement; horizontal
line=free horizontal displacement).

H
g
H
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2.4. Apply Distributed Loads

This command is used to apply uniform or non-uniform distributed loads on a surface, such as

structural loads on a footing and water pressures on a submerged surface.

Continue on the example:

Step 1: Bring back the model with node numbers [i.e., check “show node numbers”]; then
choose ‘apply distributed load’ under TOOLS, click nodes 90 and 134

Step 2: Enter ‘pressure/shear intensity’ at the 1% and 2" nodes [40 and 20 respectively], then

enter ‘inclination angle’ of the pressure [0° for pressure normal to the surface].

Note: Use an inclination angle of 90° if pressure is parallel to the surface. The pressure

intensity between the two nodes is computed by linear interpolation.

ERSAL-ZU ATIC AND DYNAMIC FINITE W

NTA..- [O[X

e e AL 15¢) 8 (ML P

1st Node (90): pressure intensity=40 kN/m/m

49

2st Node (134): pressure intensity=20 kN/m/m TEEEabRedsd9 snappec
ﬁgg ;g 89 (1004111123133
/5 67 77 a8 110121132

40 48 57 66 76 87

109120131

ko]
ﬁiﬁ‘ I |38 [¢7 |56 [65 [15 |86
1

109119130

N i 73 30 (38 |46 55 [64 [74 %5

107119129

10 16 22 29 37 45 54 63 73 84

106117128

15 21 28 36 44 53 62 72 83

W] & O

109116127

14 20 27 35 43 52 61 7 82

104119126

Ln]

ressure!shear intensity at first point

0K

Note: Refer to Section 2.7 for applying distributed loads on a submerged surface with the use of
“ywt0 > 0 Option”. The option allows an automatic calculation of water loads on the surface

from a pre-defined water level (e.g., the reservoir level).

8
7 13 19 26 34 42 51 60 70 81 104114125
VERSAT-2D Input Box M=l

13124

NN Prohlem Tit) |

Woutec Geotechnical International, Canada (www.wutecgeo.com)
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Step 3: Choose ‘model view options’ under VIEW
e check “show load vectors”
e check “show x, y axis”
e uncheck all others and click OK

Note: Force vectors are shown in red lines, starting from the nodal points.

File SETTING DEFINE TOOLS VIEW MODIFY RUN HELP

e e )15 el w [N P ]
View Options B
VIEW MODEL OPTIONS VIEW VARIABLES OPTIONS
I Show node numbers I Show deformed mesh
™ Show element numbers " Show by value and format= [0.0
¥ Show x, y axis I” Show variable by color
Efevation - ¥|| | - snow material color - -
R Value ranges for color
™ Show material number
1 05
I™ Show layers by color ‘m 5
Y -1
[~ Show boundary conditions o
55 0 1 Reverse color ™
™ Show water level /
Select a variable
¥ Show load vectors
Q Static output
=
s ™ Show Color Legend at o
X=0 Y=o - 8}
e
Nate: Due to conflicting. only one of the o] .
following quantities is shown in Dynamic output
50.0 descending priority: 1). show layers by ol o]
color: 2). show deformed mesh: 3). show
] material color. 4). show variable by color. ol 0.65
ol [ad
00 B OK CANCEL o fe
[10.0
|
100 300 50.0 700 90.0 T10.0

Distance -X (m)

Step 4: Choose “setup static analysis/setup window” under DEFINE. The forces/loads on nodes
90, 101, 112, 123 and 134 are calculated by the program and shown in this window for
review [click “Exit Setup” to close this window].

Setup Static Analyses
General Parameters for Static Analyses of the Six
Application Cases:

Applying Nodal Forces or Loads

1. Adding Sail Layers Mode Num | Fx ey Fy a
2. Applying Nadal Loads » Hgp 0 0 -93.75
3 Applying awater Table or Pare Pressure 1m 0 0 -175
4. Revorning Soil Layers e 0 0 150
i 123 0 0 -125
5. Modify Material Properties 134 0 0

-56.25 ﬂ
B. Combination of any of the abowve five cases; v = - -
Loads are divided into this
) number of increments LSTEP= |1
Mo. of elements hawing lﬂi
stresses (NFRE) Applying aWater Takle

Maxirnurm no. 10 point x-coor y-coor of water table
iterations ([ TERMX)

Allowed unbalanced farce
B ) 0.5
before quiting anakysis

H
g
H
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2.5. Assign Soil Zones

Continue on the example:

Step 1: Bring back the model with node numbers [i.¢., check “show node numbers”]; then choose

‘assign soil zones’ under TOOLS. Click four points as shown below.

Step 2: Enter soil material number in the Input Box [1 for soil zone 1] and click OK. Elements
inside the area bounded by the four points are assigned to Material #1.

Iode snapped=134

133

132

131

130

129

5

Hode snapped=12

E VERSAT-2D Input Box
INPUT MATERIAL NUMBER [UP TO NMAX]=">

oK | Cancel \
| T 1] T T ta} L a1} pak: Lzl LU E ||4124
1

1 | | 1 1 |
100 300 500 70.0 900 1100 1300

134 nodes 115 element(s) position x=43.577 y=113.804 STATICON Problem Title

Woutec Geotechnical International, Canada (www.wutecgeo.com)
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Step 3: Repeat above steps but assign Material #2 to the red zone shown in the next figure
Step 4: Choose ‘model view options’ under VIEW

e check “show element number”
e check “show x, y axis”
e check “show material color”
e uncheck all others
e click OK
B VERSAT-2D STATIC AND DYNAMIC FINITE ELEMENT ANALYSIS OF CONTINUA =[o X
File SETTING DEFINE TOOLS VEW MODIFY RUN HELP
sive |[]] orr | LA |3 | 4 1)L W el ]
" View Options
VIEW MODEL OPTIONS VIEW VARIABLES OPTIONS
I Show node numbers I Show deformed mesh
¥ Show element numbers ™ Show by value and format=  |0.0
¥ Show x, y axis [~ Show variable by color
¥ Show material color
Value ranges for color
I~ Show material number
I Show layers by col L ’7'05
ow layers by color los 5
I Show boundary conditions ’0— ’.‘7 Reverse color ™
I” Show water level ~
Select a variable
I Show load vectors & P
atic outpu
I Show Color Legend at r o 111 1oy 1o
X=0 __Y=-[o (e
o - 10 103 105 106 107 108 10
-
Puﬁfw‘E’guﬁu‘?nﬁ‘”lfﬁlghﬂy‘f“‘me Dynamic output 95 102 9% a7 e8| 09| 109 10
descending priority- 1). show layers by o (0] 94
color: 2). show deformed mesh: 3). show
material color; 4). show variable by color r W 85 86 a7 88 89 90| @1 92| @3
ol [ad
74 75 76 77 78 79| 80| 81| 82
OK CANCEL (o] (o]
[300°
X
00 00 200 300 00 500 500 700 300 900 1000 1100 120.0

Notes:
°

Suggest saving the data as demo3.sta

The color codes for material zones are always the same as follow:

VvV V V V VYV V V V

and more

Yellow for Material #1;
Red for Material #2;
Blue for Material #3
Green for Material #4
Orange for Material #5
Dark blue for Material #6
Brown for Material #7

H
g
H
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2.6. Use of Beam or Truss Element!

Define beam or truss elements: choose ‘Assign beam/bar elements’ under TOOLS, then click
on screen to select two nodal points.

» This action does not add nodes, but add elements.

» All nodal points on the line segment within the two nodes are assigned as beam or
bending elements when the “beam” option is chosen so, or

» One truss element is added to the model to connect the two nodes when the “truss” option
IS chosen.

> Nodes on a beam element are assigned rotational degree-of-freedom in addition to the
two translational degree-of-freedoms, as shown in blue circles.

» Itis recommended that this action be performed at the end of a mesh construction.

- 111 " " " "
90.0

10823 104 108 10§ 107 108 10

95 102 K22 96 97 9| 88| 100 A0

a4 BA 86 a7 21 88 kL) an a1 a2 83

50.0
58 70 59 60 61 B2 63 19 64 [ 66| 67| 68| B9

43 44 46 46 47 48 48 a0 18 &1 62 A3 64 A6 i)

29 30 N 3z 32 34 35 36 1737 38 29 40 4 42

100 300 50.0 700 EDXil 1100 1300

Note: This figure on beam element is shown for display only. The beam elements are not
included in the example that is presented earlier and later.

! The beginner who is not so familiar with VERSAT-2D finite element setup should avoid using BEAM elements. It is
recommended that BEAM elements be invoked only by advanced users.
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2.7. Use of ywt0 > 0 Option?

Water loads on submerged surface (such as the upstream slope of a dam with a reservoir) can
change when the submerged surface undergoes significant amount of ground deformations. In a
large strain static analysis or in a dynamic analysis for earthquake loading, it is sometime
necessary to update the water loads on the submerged surface to reflect the change of geometry
resulting from ground deformations. The water loads can be automatically updated according to
the new geometry by using the “ywt0 > 0 option”.

The use of “ywt0>0 option” will result in
1. All nodal loads and static pore water pressures (PWP) be set to zero

2. In every step of analysis, new water loads on submerged surface nodes be computed
using the assigned water level “ywt0”.  Note: Nodes in the “Applying Nodal
Forces/Loads” Window are used in this calculation, and these nodes must be from left
to right on one surface in the model.

3. In every step of analysis, static PWP in elements will be re-calculated using the
assigned water table and the deformed mesh. Therefore, the static PWP must be
defined using Method 1 with a water table, not using Method 2 with values
(Technical Manual Section 2.7).

Computing loads from water pressure:

Choose “Verify or use water loads from ywt0” under TOOLS. This option allows that water
loads on a submerged ground surface be calculated by the program automatically using a defined
water level of “ywt0”, such as in a reservoir. The parameter “ywt0” is specified in a setup
window in Figure 3.1 (Section 3.1 bullet 7) for a static analysis and in Figure 4.1 (Section 4.3
bullet 9) for a dynamic analysis. The detailed instructions regarding its usage are also provided
in the VERSAT-2D Processor when the option is invoked.

2 The beginner who is not so familiar with VERSAT-2D finite element setup should avoid using ‘ywt0 > 0 option’. It is
recommended that this option be invoked only by advanced users.
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3. SETUP A STATIC ANALYSIS

3.1. First Static Run-Run 1

A static analysis is setup using DEFINE. Choose ‘General parameters’ to define key
parameters that control the analysis including

>
>
>
>

An option for gravity ON [default] or OFF

constants of gravity acceleration, unit weight of water and atmospheric pressure
an option of linear or nonlinear [default] static analysis, and

an option for small strain [default] or large strain (updating mesh)

The default constants are for metric units.

Choose “Setup static analysis” and then ‘Setup Window’ to start a setup window as shown in
Figure 3-1. An input file for a static analysis can contain one or multiple static runs. The first of
these static runs is called “Run 1”. A static run may include one or a combination of the
following parameters or load applications:

1. Add Soil Layers [“turn on” gravity force]:

>
>
>

A static run can start with NPRE elements that already have stresses [default NPRE=0].
Gravity forces have already been applied to these [NPRE] elements having stresses.

A sub window “Apply No of Elements in a Layer” is used to add one layer or multiple
layers of elements to NPRE to which gravity forces are applied. A static run can contain
multiple load applications, i.e., multiple layers.

Gravity is applied or turned on layer by layer, but one layer each time. Assuming the
number of elements in the layer is NADD, the total number of elements included in this
load application should be NPREypdated[ =NPRE+NADD]. All other elements with an
element number greater than NPREypdated are automatically excluded in this load
application.

At the end of this load application, elements in this layer are then included in NPRE
elements (i.e., elements having stresses) and NPRE is increased automatically.

A static run can also contain no layer of elements to be added to NPRE. In this case,
gravity forces are applied to all elements in the model and NPRE is deemed to be equal to
the total number of elements of the model. Thus, the sub window “Apply No of Elements
in a Layer” is left blank.

In addition to being used in “Run 17, this load application “Add Soil Layers” can also be
used in subsequent static runs until the updated NPRE reaches the total number of
elements of the model.

This load application “Add Soil Layers” is void when the option for gravity is set OFF.

Woutec Geotechnical International, Canada (www.wutecgeo.com) .
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2.

3.

4.

Apply a Water Table:

> A water table or a phreatic surface is defined in a sub window “Applying a Water Table”.
Points are added manually by clicking the “Add” button and entering X and Y coordinate
of a point. A water table connects all points in the sub window consecutively.

> A water table or a phreatic surface, once defined, will remain unchanged until they are
replaced/updated by another one defined in a subsequent static run.

Note: Choose ‘define water level or pore pressures’ under TOOLS to: (1) compute pore
water pressures from a pre-defined water level, or (2) assign constant pore water
pressures or pore pressure ratios within a soil zone [see Volume I: Technical Manual
for details of applications]. Detailed instructions are provided in the Processor when
this operation is invoked.

» This window may be left blank if a water table does not exist.
» LWSTEP=1 should be used

Apply nodal forces or loads:

» In addition to using ‘Apply distributed load’ under TOOLS as described in Section 2.4,
individual loads can also be added or edited in a sub window “Applying Nodal Forces or
Loads”.

» Loads should not be applied to elements that are not included in the current model as
defined by NPREypdated

» LSTEP=1 should be used.

Perform Excavation:
» This is a reverse process of adding soil layers described above.
» The option in the sub window “Performing Excavation?” is set to YES.

» The number of elements to be excavated or removed (NEXC) is entered in the sub
window “Apply No of Elements in a Layer”. Only one layer of elements should be
defined in this sub window. Multiple layers of elements should not be used for this
application.

» The element number of these NEXC elements is entered in the sub window “Performing
Excavation?”

Modify Material Parameters

» One set of material parameters are used for one static run.

» A set of material parameters will remain unchanged and effective until they are
replaced/updated by another set of parameters defined in a subsequent static run

» When initiating a new static run, a user has the option to define a new set of parameters
which can be modified from the current set of parameters.

» Modifying soil parameters from strong to weak such as strength reduction due to soil
liquefaction can cause deformations in sloped grounds.
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6. Review maximum no. of iterations (ITERMX): A static load application terminates when
ITERMX is reached or the requirement for “allowed unbalanced force...” is satisfied.

7. Review the water level parameter “ywt0” [default=0 for function not used]: For static runs,
this parameter is used only when the “large-strain” option is chosen for the analysis. See
Section 2.7 for details of the option.

Continue on the example in Step 4 of Section 2.5:
> Start “Setup static analysis” and ‘Setup Window’

> Delete the nodal forces within the sub window “Applying Nodal Forces or Loads”. They
are added later in static Run 2.

» Click “Add a layer” in sub window “Apply No of Elements in a Layer”, add two new
layers with 28 elements each.

» Click “Apply” and “Exit Setup”

General Parameters for Static Analyses of the Six Applying Nodal Forces or Loads
Application Cases:

1.Adding Soil Layers Mode Mum | Fx
2. Applying Modal Loads

3 Applying a'Water Table or Pore Fressure
4. Rewvorning Soil Layers

5. Modify Material Properties

B. Combination of any of the abowve five cases;

Loads are divided into this
number of increments LSTEP= |1

Mo. of elements having liﬂ

stresses (NPRE) Applying a‘Water Takle

Meximum na. 10 point x-coor y-coor of water table
iterations (ITERMX)

Allowed unbalanced force
i ; 0.5
before quitting analysis

T

Add Delete LWSTEP=

Apply ND_Df Elements in & Layer Performing Excawation ?
[constructionfexcavation)

no. of elements in layerl = 28
no. of elements in layer2= 28

* MO ~ YES

Add a layer Delete a layer
SFECIFY water level MEW BN FREVIOUS
for updating with
deformation water DELETE LAST NEXT
loads on an under-
wter surface, ywil RUN 1
(0. function not used) CAMNCEL
0 APPLY
EXIT SETUP

Figure 3.1 A static setup window

H
g
H

Woutec Geotechnical International, Canada (www.wutecgeo.com)



VERSAT-S2D and VERSAT-D2D Version 2021.06.09: User’s Manual

page 26

Choose ‘model view options’ under VIEW

>

>
>
>
>

check “show element number”
check “show X, y axis”

check “show layers by color”
uncheck all others

click OK

View Options

VIEW MODEL OPTIONS
™ Show node numbers

¥ Show element numbers

I Show x, y axis

™ Show material color

™ Show material number

¥ Show layers by color

I Show boundary conditions
™ Show water level

" Show load vectors

™ Show Color Legend at

X=0 Y= |0

VIEW VARIABLES OPTIONS
™ Show deformed mesh

™ Show by value and format=

™ Show variable by color

rValue ranges for color

;

0.5
E

Note: Due to conflicting. only one of the
following quantities is shown in
descending priority: 1). show layers by
color: 2). show deformed mesh: 3). show
material color: 4). show variable by color

oK | CANCEL |

[o.5 E
|o 1 Reverse color [~
rSelect a variable
 Disp - X Static output
€ Static pp
 Dis
© Su
= Acce
 FoS
= Acce
Dynamic output
€ Stress - x € CSR, and factor=
€ Stress 0.65
© Stress (o 5
5 PPR/FS

File SETTING DEFINE TOOLS

[0 sve | ore | A3 | 1 L w (M9 P |

VIEW MODIFY RUN  HELP

1100 elevation - Y (m)

=

21

144
1

4115

104

na1pg

="1h4 10
/‘ﬂ 102 ag 97

00101

a4 848 ah a7 28 a9

irdi|

74 78 PG 17 78 an

& layer 2

distance -X (m)

Figure 3.2 A window showing layers in color

i 148 1A 572 18 149 20 21 22 23 24 26 2R 28 ‘ |ayer 1
’ 1 2 3 4 5 g 7 ] g 101 11 1B 1B 1
100 300 500 700 90.0 110.0 1300
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3.2. Define Soil and Structure Parameters

Continue on the example:

» Choose ‘Input material parameters’ under DEFINE
» Enter “1” in material number box
> Select “Sand” in the sub window “Select a Material Type”
> Edit the parameter boxes as needed [default values are shown herein]
» Click “Add/modify a material” button
» Enter “2” in material number box
» Select “Clay” in the sub window “Select a Material Type”
> Edit the parameter boxes as needed [default values are shown herein]
» Click again “Add/modify a material” button
» Click “APPLY ALL” button to save and exit this window.
Input Material Parameters @
Material Number Select a Material Type PWP model parameters(DYNAMIC)
2 © Sand o Silt & Clay ¢ Elastic ¢ Beamor Truss Model Cption
o (o
Sand Model: Shear sirength, ss=f(current stresses, c, Phi) using the Mohr-Coulomb Law ) (6]
Kb n Kg m Unit Weight c Phi Rf g
[300 [o5 [100 [05 [20 [5 [35 [o Vol strain constants
MFS: modified
cl c2 K2 MFS: M
Clay Model: ss=f(pre-existing stresses); Silt = Sand Model (c, Phi), or Clay Model (c, k). |7 |O4 ‘0 05 ‘300
Kb n Kg m Unit Weight c k Phi Rf _
Seed's pore water pressure mode
[300 o [100 o [18 [100 o2 o o
(N1)60 CRR beta alpha theta
Elastic Beam or Truss \15 |O 16 \0.25 \1.4 \0.7
Kb Kg Unit Weight Ke Area Mom of Inertia | Unit Weight Rb Strength / Slifness afier liquefaction/sofening
3000 [1000 [19 [200000 [0 01 24 [1.0 cliq k_ig Kg_liq
[25 [0.12 [100
LIST OF MATERIALS
#SOIL Kb n  Kg m UnitW c Phik e cofeng ode
1 SAND300 05 100 05 20 5 35 Ru_0 gamm_H0% gamm_H%
2 CLAY300 0 100 0 18 100 O - - -
035 [10 [12
ELASTICC Kb Kg  Unitw
BEAMITRUSS: Ke Area | UnitW Rb() STATIC RUN 1
CANCEL Add/modify a material
APPLY ALL Delete a matenial

Figure 3.3 A window showing material parameters defined in Run 1
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3.3. Second and More Static Runs

A new static run is normally required when nodal loads, or the water table, or soil properties are
changed. These quantities are unchangeable within a static run.

Continue on the example to setup a second static run — Run 2:
> Start “Setup static analysis” and ‘Setup Window’ again.
» Press “NEW RUN” button and “YES” to initiate a new static run

» “Copy Soil Parameters from RUN 1?” and “No” to not redefine soil parameters. If
changes on parameters are required, then answer “YES” to copy and modify.

» Click “Add a layer” in the sub window “Apply No of Elements in a Layer”, add one new
layer with 59 elements as shown in Figure 3.4

Setup Static Analyses
General Parameters for Static Analyses of the Six Applying Nodal Forces or Loads
Application Cases:

1. Adding Sail Layers Mode Num | Fx My Fy A
2. Applying Nodal Loads 4 90 0 0 -93.75
3. Applying &Water Table or Pore Fressure 1m 0 0 -175
4. Revorning Soil Layers e 0 0 150
123 0 0 -125
b, Modify Material Properties 134 0 i

-56.25 ﬂ

B. Combination of any of the abowe five cases; . = -
Loads are divided into this
. numbet of increments LSTEP= |
MNo. of elements hawing li
stresses (NFRE) Applying aWater Tabkle

hdeximurn no. point  x-coor w-coor of water table
iterations (ITERKMX)

1 0000 40000
Allowed unbalanced force li

2 130,000 40.000
before quiting anakysis

Acd Delate LWSTEP= |1

Apply ND.DT E"?ment?f in a Layer Ferarming Excasation ?
(construction/excavation)

o r
no. of elements in layerl= 59 e =
Add a layer Delete a lawver
SPECIFY water lewvel MNEW RN PREVIOLIS
for updating with
deformation water DELETE LAST NEXT
laads on an under-
wter surface, ywil RUN 2
(0. function not used) CAMNCEL
0 APPLY
EXIT SETUP

Figure 3.4 A static setup window for Run 2
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>

Figure 3.5 A window showing layers and loads for Run 2

Click “Add” in the sub window “Apply a Water Table”, add two points to define a water
table as shown in Figure 3.4.

Click “Apply” and then “Exit Setup”.

Follow steps in Section 2.4 to apply non-uniform distributed loads on the surface from
node 90 to node 134 [Section 2.4 is there for instruction purpose].

Go back to “Setup static analysis” and ‘Setup Window’ again. The window as shown in

Figure 3.4 should contain the loads for nodes 90, 101, 112, 123 and 134.

Refresh the model using “Show layers by color” and “Show load vectors” as shown in

Figure 3.5

© VERSAT-2D STATIC AND DYNAMIC FINITE ELEMENT... [= [O|X]

File SETTING DEFINE TOOLS VIEW MODIFY RUN HELP

[ e e 0 ore | A 3¢ | ] N1 @ P

distance -X (m)

[110.0 .
elevation - Y (m)
| — 44 192113114115
90.0 C’—:; ] LU
/-/9( 04 104 104 1pAR1071081Dp9
| 95 1032 ai g7 a8 100101
700 ‘_
5“_25 a4 Ftal a8h a7 88 29 qp 9B Iaé?jf\;lz
/,:_{; 71 7 74 75 7R 77 78| 78 80 84 &p D
50.0
Gy—Ai 0 A9 Al £1 A2 A3 A4 ARl GRE GF GB A9
| 43 44 48 4R 47 48 49 a0 a1 A2 | AR A4 AR AR
00 29 30 el 32 33 34 35 36 37 28] 30 40 4)t 4
| 18 16 17 18 19 20 21 22 23 24| 28 28 2F 28
100
1 2 3 4 [ B 7 g g 101 14 1B 161
100 30.0 50.0 700 90.0 110.0 130.0

Note: A static run can be deleted by pressing the “DELETE LAST ” button. Only one static run

with the highest run number is deleted at a time.
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3.4. Save Data and Start A Static Analysis
Continue on the example:

» Save the data as Run2.STA using ‘Save Data’ under FILE.

» Choose ‘Run versat-s2d’ under RUN

» Enter the User Name and Password

> Press “Connect Now’ (see Figure 3.6)

» Select the input file “run2.sta” to run after an authorization is obtained

ozl

= || B || 2
Step 1: Get Authorization from Internet

User Mame |gwu
P ’ Abort Analysis (warning: don't
sswor use x-button to stop a run)
Connect Now Successfull Goto STEP 2

|Step2: Select Fileto Start |

Run 3work 3 iteration 5 unbalanced force=003 UF ratio=18678e-007
Run 3work 4 iteration 2 unbalanced force=74.10 UF ratio=52318e-004
Run 3work 4 iteration 5 unbalanced force=027 UF ratio=19153e-006
Run 3work 4 iteration 5 unbalanced force=027 UF ratio=19153e-006
Run 3work & iteration 3 unbalanced force=346 UF ratio=2 4203e-005
Run 3work & iteration 5 unbalanced force=000 UF ratio=6.0323=-009

data file: C:\201\Ex_d2017_UpperSanFernandoDamiUSF_4_FINAL sta

Figure 3.6 A window showing ‘Run versat-s2d’ under RUN
Note:

» Results of this static run include a file named “run2.pr4”. This file is needed in a
subsequent dynamic time-history analysis.

» An Internet connection is required in order to run any analyses using VERSAT-2D.
However, it is not required for data preparation.

3.5 Input Files for Static Run

The input files for a VERSAT-2D static analysis consist of 1 file or 2 files:
1. Filename.STA (main input file prepared in VERSAT-2D Processor)
2. Filename.PRX (pre-existing stresses, and it is needed when NPRE > 0)
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4. SETUP ADYNAMIC ANALYSIS

4.1. Turn On Dynamic

In general, a dynamic analysis can start only when gravity-induced static stresses within a finite
element model are determined in a static analysis. As such, the dynamic analysis model can be
constructed from the same finite element mesh and soil zones as that for the static stress analysis.

Continue on the example in Section 3 and prepare data for a dynamic run:

M b e

Restart the Processor

Load the setting file (see Section 2.1) using “Load Setting” under SETTING
Load the data file “run2.sta” (see Section 3.4) using “Load Data” under FILE
Click ‘Dynamic On’ under SETTING and select “Yes”

Note: “DYNAMIC ON” should be seen at the bottom of the Processor window.

4.2. Key Parameters for a Dynamic Analysis

Choose “General parameters” under DEFINE

Gravity on/off: On [default]

» Choose Gravity Off [enter 1 in the box] to run dynamic analysis of a 1D soil column

Gravity acceleration: 9.81 m/s? [default] for metric unit

> Enter “-9.81” in this box to use a sine input instead of a time-history input. The use of a
sine input is demonstrated in an example file called ex_d2.dyn.

Method of analysis:

» [default] - Non-linear analysis (ICHANG=1)

» Select “Non-linear Effective Stress” (ICHANG=2): to include dynamic pore water

pressures in the calculation of soil strengths and ground displacements (see Section 3.5 of
the Technical Manual for details)

> Select “ICHANG=3 for Advanced User”: This option is available since v.2019.5.8. Its
functionality is the same as “Non-linear Effective Stress Analysis” or ICHANG=2. See
Section 4.11 in the User Manual for further explanations.

Note: Geometry mesh is always updated with deformation (large-strain option is always ON) in
the dynamic analysis.
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4.3. Setup a Dynamic Analysis

Continue on the example and name the input file of the dynamic analysis as “run3.dyn”:

Choose ‘Setup dynamic analyses’ to start a setup for dynamic analysis.

2. Enter “115” for NPRE. When the dynamic analysis starts, the program automatically looks
for an input file named “run3.prx” to read in the stresses of these “115” elements. It is
required that the file “run2.pr4” [see Section 3.4] be renamed manually as “run3.prx” prior
to this dynamic analysis. Otherwise, the program stops because of incomplete input files.

3. Select “Hori Base Acceleration” [default] under a sub window “Options for input
motions/forces (NBF)”. When the dynamic analysis starts, the program automatically looks
for an input file named “run3.ACX” to read in time-history data of accelerations at the rigid
base (the input ground motions). It is required that the file “run3.ACX” be created prior to
the dynamic analysis. Otherwise, the program stops because of incomplete input files.

>

The data format for “run3.ACX” is shown in the left and lower area of the setup window,
as shown in Figure 4.1, where NPOINT is the total number of acceleration data to be used
in the analysis, DT is the time interval of the accelerations, FAMPL is a linear scaling
factor by which the data are multiplied; and

NRVSUB is number of sub time step: 0 for no modification to the ground motion data
and time interval provided in the file run3.ACX, 1 for inserting one point, 2 for inserting
two points, 3 for inserting three points, and so on, to two consecutive data. All sub time
steps are created by linear interpolation of acceleration data and time interval DT.

NLINE is number of record lines, and NoPerLine is number of data per record line. Data

points must be in CSV format or comma delimited.

The data for ground motions are in the same unit as the gravity acceleration [m/s? for

metric unit].

It is also noted:

e When the option “Hori + Vert Base Accelerations” is chosen, another input file
“run3.ACY” is required. This file provides data for vertical ground accelerations at the

base of the model. It is noted that the time interval (DT) must be same for “run3.ACX”
and “run3.ACY”’; otherwise DT from run3.ACX is used for run3.ACY.

e When the option “Forces at Nodal Points” is chosen, the input force time history is
provided in the file “run3.FXY”.

e When the option “Hori. Outcropping Velocity” is chosen, the input velocity time
history is provided in the file “run3.VEX”.

e The data format is same for “run3.ACY”, or for “run3.ACX”, or for “run3.FXY”, or for
“run3.VEX”. Refer to “NicoM_1c.ACX” in the examples library [copy
“NicoM_1c.ACX” to “run3.ACX”].
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Setup Dynamic Run e T =]
Options for input motions/forces (NBF) Parameters for Outcropping Velocity Option
 Hon Base Acceleration. *.ACX viscous base  shearwave wave starts travelling
£ Hori + Vert Base Acceleration, " ACX/ACY | massdensity  velocity travellingx0=  speed from x0
" Forces at Nodal Points, * FXY 2 2500 o 30000000
£ To modify
number of elements * ListA i " ListD
having stresses 15 . | . |
(NPRE) Add an item Delete an item
viscous damping A. List of Modes/Elements for Time Histories
(%) mass 05

nodefelementno. & response code(1 to 6 for node; -1 1o -6 forelem
9 1 90 3 90 4 20 -2 20 -3

viscous damping

(%) stiffness 2

time interval (s) for saving

output Uty C. Define Locations of Dynamic Loads

nldof & fdof

time interval (s) to update

viscous damping 15

PWP not generated afte
this time (sec) 50
D. Applying Water Tables

static iterations at end -
of dynamic loads 100 |:_--:-|nt x-coor y-coor of water table

120 000 i Ann
£ SU Ul UL

[NOTES:

|".AC}{, ACY (hori, vert base accelerations), Applying Nodal Forces/Loads
*VEX (hori. outcropping velocity), * FXY (force) SPECIFY
— - water level for
|".F'F{>i (existing stresses when NPRE=0) Mode Num | Fx Moy Fy updating with
|a|‘-'—.- to be prepared manually. b 90) 0 0 9375 CreTEler
- - 101 0 0 475 loads on an
|F-:-|‘mat same for ACX, ACY, VEX, FXY: under-water
1 Tle 112 o 0 -150 surface, ywt0
|Line 1: Title 123 0 0 125 (0. function
|Line 2:NPOINT, DT, FAMPL, NRVSUB 134 0 0 56 95 not used)
|Lin-': 3 NLINE, NoPerLine K o
| data separated by comma (m/s"2. fi/s"2 h | | ﬂ
| . m/s or fifs (velocity); or kNfm for forces) CANCEL | APPLY ‘

Figure 4.1 A setup window for a dynamic analysis

4. Review, modify as needed, the following parameters:
» viscous damping (%) of mass [=km, See Section 3.2 of the Technical Manual, default=0.5]
» viscous damping (%) of stiffness [=Ak, also see Section 3.2, default=2]

> time interval (s) for saving output [default=100 sec]: All recordable quantities such as
accelerations, displacements, shear stress, and pore water pressure are printed at this
specified time interval (in sec) in the output file (Filename.oud) and in the plotting files
(Filename.dis, Filename.sig).

> time interval (s) to update viscous damping [default=1.5 sec]: In a nonlinear analysis, the
frequencies of the model vary with time of shaking. The viscous damping constants (a, b
in Section 3.2 of the Technical Manual) are updated at the specified time interval (in sec).
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» PWHP not generated after this time (sec) [default=50 sec]: In a non-linear effective stress
analysis and within this specified time of shaking, dynamic pore water pressures are
calculated and added to stresses of soil elements and are included in the force
equilibrium. Beyond this time, dynamic pore water pressures are kept the same as at this
time, i.e., constant with time. Enter a large number (e.g, 999) when this restriction is not
required.

» Static iteration at end of dynamic loads [default=100]: At the end of shaking, static
equilibrium analyses are carried out. All quantities related to vibrations such as
accelerations and velocities are set to zero in this post-dynamic static analysis.

5. The sub window “To modify” allows changes to List A, C (enabled when the model is
subjected to dynamic loads instead of ground shaking, not used in example “run3.dyn”) and
D. While the option “List A” is chosen and on, time history response of nodes and elements
can be requested through the sub window “List of Nodes/Elements for Time Histories” as
follows:

» Click on “Add an item” and enter “node or element no & response code ”

> Repeat above for each pair of “node or element no & response code ” until the required
number of response points are entered.

Notes: The requested time history data are saved using the file name of the input data and a
file extension (or file type) of CSV such as NicoM_1c.csv, run3.csv etc. The time history
data are compatible with Microsoft Excel.

Response codes for saving node response data (and also in PSPA output) are:
1 = X-displacement
2 = X-velocity
3 = X-acceleration
4 = Y-displacement
5 = Y-velocity
6 = Y-acceleration
7 = X-acceleration at the base
8 = Y-acceleration at the base
Response codes for saving element response data (and also in PSPA output) are:
-1 = Stress-X (ox) or bending moment at centre of a beam element
-2 = Shear Strain (in %)(yxy) or axial force of a beam/truss element
-3 = Shear Stress (txy) or shear force of a beam element
-4 = Pore Pressure Ratio (PPR) or bending moment at J-node of a beam element
-5 = Stress-Y (oy)
-6 = Normal strain X (in %) (ex) (In PSPA output: peak Gamm_max in 1% set,
DynStressRatio in 2" set)
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-7 = Normal strain Y (in %) (ey)
-8 = Volumetric strain (%)
6. The option “List B” is disabled in Version 2011.

7. While the option “List C” under the sub window “To modify” is chosen and on, location and
magnitude of dynamic loads are entered by clicking “Add an item”. The input box requires
two parameters: a) nldof = degree-of-freedom number (printed in run3.oug) at which the load
is applied, and b). fdof = linear scaling factor for nldof by which the input loads in run3.eql
are multiplied. This option is not used in this example.

8. While the option “List D” under the sub window “To modify” is chosen and on, a water table
can be defined by clicking “Add an item”. A water table already defined in a static analysis
is maintained and transferred into a dynamic analysis when “Dynamic On” is turned on.

9. Review the water level parameter “ywt0” [default=0 for function not used]: An input box is
located above the “APPLY” button in Figure 4.1. This function is invoked by entering a
positive value (commonly the reservoir elevation) in the input box. Be very cautious in
initiating this function. Its usage is recommended when submerged ground surface is
expected to have large deformations under loading or ground shaking.

Refer to Section 2.7 for details of requirements and its implication of ‘ywt0 > 0 option’.

4.4. Assign Boundary Conditions for Dynamic Analysis

In addition to the boundary conditions used in a static analysis as described in Section 2.3,
boundary conditions used in dynamic analysis also include the free-field stress boundary and the
viscous boundary.

Free-field Stress Boundary

The free-field stress boundary is described in Section 3.12 of VERSAT-2D Technical Manual.
This boundary condition should only be used in a dynamic analysis and only for side boundaries,
and it is assigned by typing boundary code “-1” in the input box in Figure 4.2 (see Section 2.3).

Viscous Boundary

The viscous boundary must be, and is only, applied when “Hori Outcropping Velocity” is chosen
as the option for input ground motion in Figure 4.1. In order to use this option, the finite element
model should have a horizontal base with a viscous boundary. The viscous boundary condition
is assigned by typing boundary code “-2” in the input box in Figure 4.2 (see Section 2.3).

"4 VERSAT-2D Input Box [
|| boundary code=(0: xy free; 1:y free; 2: x free; 3: xy fixed; -1: ff; -2: X viscous
OK ‘ Cancel |
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[T5] VERSAT-2D STATIC AND DYNAMIC FINITE ELEMENT ANALYSIS OF CONTINUA

File SETTING DEFINE TOOLS VIEW MODIFY RUM HELP

[ 9 I o A 3] | w (1)@ o ]

Figure 4.2 A finite element model assigned with free-field stress boundary on the sides and
viscous boundary at the base

4.5. Define Soil and Structure Parameters for a Dynamic Analysis

Continue on the example:
1. choose “Input material parameters” under DEFINE to define material parameters for

dynamic analysis as shown in Figure 4.3.
Enter “1” in material number box

Select “Sand” in the sub window “Select a Material Type”. Note that the sub window “PWP
model parameters (DYNAMIC)” is now enabled for PWP model and its parameters.

Edit the parameter boxes as needed [default values are shown herein, except Rs=1000]
Click “Add/modify a material” button

Enter “2” in material number box

Select “Clay” in the sub window “Select a Material Type”

Edit the parameter boxes as needed [default values are shown herein]

© ©° N o o bk

Click again “Add/modify a material” button

10. Click “APPLY ALL” button to save and exit this window.

Notes:

» Click on a parameter box in blue to see further explanations on the parameter
» See Section 3.4 of the Technical Manual for details of R¢

» See Section 3.5 of the Technical Manual for details of various PWP models.
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nput iviaterial Farameters

Material Number Select a Material Type PWP model parameters(DYNAMIC)
13 Enter ||| cSand @ Sit C Clay  Elasic C BeamorTruss Model Option
" MFS " Seed's with (N1)60
Sand Model: Shear strength, ss=f(current stresses. c. Phi) using the Mohr-Coulomb Law " modified MFS * Seed's with CRR
Kb n Kg m Unit Weight c Phi | Rf ¢ zero dynamic pore water pressure
300 o5 [100 o5 [20 E [35 o Vol. strain constants .
MFS: modified
cl c2 K2 MFS: M
Clay Model: ss=Ff(pre-existing stresses). Silt = Sand Model (c, Phi). or Clay Model (c. k). I04 |1 ID 05 |'*CD
Kb n Kg m Unit Weight [ k | Phi Rf
Seed's pore water pressure model
[19200 o [1920  fo [205 |5 02 |36 [750
(N1)60 |CRR15 | beta alpha theta
Elastic r Beam or Truss [15 [o545 |08 |2 [05
Kb Kg U wt [C]_a [Clb Ke Area | Mom. Ixy | U.Wt | Rb Strength / Stiffness after liquefaction/softening
[3000 1000 |19 [o [0 _lzascua o1 Jo1 [24 10 c_liq k_liq Kq_liq
64 [0.12 [100
LIST OF MATERIALS ~
#S0I Kb n  Kg m UnitW c Phik il Lt
1CLAY2400 0 800 0 196 50 O Ru_0 | gamm_H0% | gamm_H% | Sr_fac
2SAND18000 O 1800 O 196 0 35
3 CLAY18000 0 1800 0 196 145 0 0.3 [35 [10 [
4 SAND 18000 0O 1800 O 196 0 35
5SAND18000 0O 1800 O 196 0 35
6 SAND20500 0 2180 0 20 0 40 DYNAMIC
7 SAND20500 0 83880 0O 20 0 40 ! )
8 SAND16050 05 1605 05 20 0 38 CANCEL | Add/modify a material |
9 SAND20500 05 2600 05 20 0 40
10 SAND 16050 05 1605 05 20 0 38 v APPLY ALL | Delete a material |

Figure 4.3 A window showing input parameters for a dynamic analysis (v.2019.10.3 and later)

4.6. Save Data and Start A Dynamic Analysis

Continue on the example:
» Save the data as run3.dyn using ‘Save Data’ under FILE.

Choose ‘Run versat-d2d’ under RUN
Enter the User Name and Password
Press “Connect Now’

Select the input file “run3.dyn” to run after “Successful! Goto STEP 2” in red is obtained
as shown in Figure 4.4.

>
>
>
>

H
g
H
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a5 Running VERSAT-D2D

-— -

= | ] -

Step 1: Get Authorization from Internet

User Name gWU
Password

Step 2a. Load csv File for multi-runs:
m_EQ levels with n_EQ records

Connect Now

Abort Analysis (warning: don't use x-button to

stop a rum)

No. of VERSAT-D2D runs in process: 1 Single

Run

Step 2b: Select .dyn File >> START

time=3.988
time=3.996
time=4 000
time=4.004
time=4.012
time=4 016
time=4.024
time=4.032
time=4.036
time=4.044
time=4.052
time=4.056
time=4.064
time=4 063
time=4.076
time=4.084
time=4 092
time=4.096
time=4.104
time=4.112
time=4.116
time=4 124
time=4.132
time=4.140
time=4 143

steps=997 unbalanced force=533.15 gravity force = 160254.81
steps=999 unbalanced force=516.38 gravity force = 160254.25

steps=1000
steps=1001
steps=1003
steps=1004
steps=1006
steps=1008
steps=1009
steps=1011
steps=1013
steps=1014
steps=1016
steps=1017
steps=1019
steps=1021
steps=1023
steps=1024
steps=1026
steps=1028
steps=1029
steps=1031
steps=1033
steps=1035
steps=1037

unbalanced force=507.69 gravity force = 160253.86...computing eigen values_..
unbalanced force=2163.35 grawty force = 160253.67

unbalanced force=613.52
unbalanced force=563 27
unbalanced force=523.01
unbalanced force=501.65
unbalanced force=495.19
unbalanced force=509.57
unbalanced force=550.66
unbalanced force=571.11
unbalanced force=574 49
unbalanced force=576.85
unbalanced force=627.84
unbalanced force=639.92
unbalanced force=658 65
unbalanced force=752.39
unbalanced force=840.47
unbalanced force=882.95
unbalanced force=864.10
unbalanced force=860.08
unbalanced force=807.09
unbalanced force=756.26
unbalanced force=768 67

gravity force = 160253.08
gravity force = 160252.79
gravity force = 160252.23
gravity force = 160251.69
gravity force = 160251.43
gravity force = 160250.93
gravity force = 160250.47
gravity force = 160250.25
gravity force = 160249.85
gravity force = 160249 .66
gravity force = 160249.32
gravity force = 160249.02
gravity force = 160248.76
gravity force = 160248.64
gravity force = 160248.43
gravity force = 160248.26
gravity force = 160248.19
gravity force = 160248.07
gravity force = 160247.99
gravity force = 160247.94
gravity force = 160247 .91

data file: C\2019WERSAT-2D\testiDynamiclUSF_Seed . DYN

Figure 4.4 A window (v.2019.5.8 and later) showing a dynamic run in progress: A Single Run

4.7. Dynamic Analysis of One Dimensional Soil Column

An example of this application is provided in the example library under “example_1D”.

1. Determine static stresses: Static stresses are computed from a static analysis of the one
dimensional (1D) soil column. An example 1D soil column is shown in Figure 4.5.

» For the static analysis, the boundary conditions of nodes along the two sides are “free in
vertical displacement”, i.e., boundary fixity = 1 (see Section 2.3).

» The static stresses are required in order to compute the stiffness and shear strength
parameters of the 1D soil column in a dynamic time-history analysis.
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2. Follow steps in Sections 4.1 through 4.6 for a dynamic analysis of the 1D soil column with
the following special treatments:

» For the dynamic analysis, the boundary conditions of nodes along the two sides are “free
in horizontal displacement”, i.e., boundary fixity = 2 (see Section 2.3).

» Specify “Gravity OFF” in “General parameters” under DEFINE. Refer Section 4.2 for
this option.

VERSAT-1D MODEL

35.0 Node Number on 2 sides
Elem Number at centre

30.0 Soil Zones by Color

25.0

20.0

[15.0

[10.0

50

0]

Figure 4.5 An example 1D soil column showing soil zones, a water table and boundary

conditions for a static analysis

4.8 Input Files for Dynamic Run

The input files for a VERSAT-2D dynamic analysis consist of a minimum of 3 files:

1.

2.
3.
4

Filename.DYN (main input file)

Filename.PRX (pre-existing stresses)

Filename.ACX (acceleration data for horizontal or X motion)
Filename.ACY (acceleration data for vertical or Y motion)

H
g
H
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4.9

4.10

In above, “Filename.DYN” is prepared using VERSAT-2D Processor, i.e., the main window of
the program; “Filename.PRX” is renamed from an output file of the static stress analysis (See
Section 4.3 bullet 2); “Filename.ACX” is explained next, in Section 4.9 below. The 4™ file,
“Filename.ACY” is required when the vertical acceleration is also applied as input motion. The
ACY file has the same format as ACX file.

The elastic base (instead of a rigid base) with “Outcrop Velocity” input option can be selected
(See Section 4.1 of the Technical Manual, Section 4.3 bullet 3 and Figure 4.1 of this User
Manual). In this case, “Filename.ACX” is replaced by the following:

5. Filename.VEX (outcrop velocity data for horizontal or X motion)

Instead of applying ground motions, forces at nodal points can be applied and selected (See
Section 4.3 bullet 3 and Figure 4.1 of this User Manual). In this case, “Filename.ACX” is
replaced by the following:

6 Filename.FXY (nodal forces to be applied at the specified nodes)
Input File Format for Filename.ACX, .ACY, .VEX, and .FXY

See Notes in Figure 4.1 and Section 4.3 bullet 3 of this User Manual for details. All these input
files use the same format and contain 3 lines of heading and then data values:

e LinelTitle (Record name, date, component, etc.)

e Line 2: NPOINT, DT, FAMPL, NRVSUB

e Line 3: NLINE, NoPerLine  (total number of lines from Line 4, and data points per line)
e Line4 data values separated by comma

In above, NPOINT is number of data to be used in analysis, NPOINT <= NLINE*NoPerLine;
DT is the time (sec) increment for the data; FAMPL is scale factor to be applied to the data in
analysis; NRVSUB is the number of sub time step (0, 1, 2, 3, 4, or higher integer). The time
increment used in analysis “dt” is equal to DT/(1+NRVSUB), and data are added using a linear
function in between “dt”.

The data for ACX, ACY should carry the same unit as gravity acceleration, e.g., m/s?; the
corresponding data for VEX should be in “m/s”, and FXY data should carry the unit of “kN”".

Input and output files for PSPA Run

An additional input file, “USF-2012-m-SUB.PSPA.csv” OF “USF-2012-m-CRU.PSPA.csv”, 1S required to
conduct the PSPA multiple analyses; this file is loaded by selecting Step 2a in the VERSAT-
D2D Run window. See below a list of files in “VERSAT-2D_2019_Examples\Ex_PSPA-runs”:

H
g
H
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£a] USF-2012-m-SUB.PSPA.csv

£a] USF-2012-m-CRU.PSPA.csv

USF_2012_m.prx

USF_2012_m.dyn EQ-SUB-5.ACX EQ-SUB-4.ACX
EQ-SUB-3.ACX EQ-SUB-2.ACX EQ-SUB-1.ACX
EQ-CRU-5.ACX EQ-CRU-4.ACX EQ-CRU-3.ACX
EQ-CRU-2.ACX EQ-CRU-1.ACX static

output out_PSPA

See below the content in the file “usF-2012-m-crRu.PsPA.csv> for detailed input format for setting up
this input file. The highlighted areas are required and read; the rest are for information only.

A B C D E
1 9 9 prob-level x 5 EQ =45 runs
2 Probh.Levl SF x SF y AEP Return-Yr
3 P1 0.46 0.46 0.001 1000
4 p2 0.6 0.6 0.000555556 |1800
5 P3 0.74 0.74 0.00040404 2475
6 P4 0.88 0.88 0.000266667 |3750
7 P5 1 1 0.0002 5000
8 P6 1.15 1.15 0.000125 8000
9 p7 1.32 1.32 0.0001 10000
10 P8 1.53 1.53 6.67E-05 15000
11 P9 1.69 1.69 0.00005 20000
12 |5 N-points dt Comments
13 EQ-CRU-1 902 0.02 EQ-CRU-1
14 EQ-CRU-2 902 0.02 EQ-CRU-2
15 EQ-CRU-3 902 0.02 EQ-CRU-3
16 EQ-CRU-4 902 0.02 EQ-CRU-4
17 EQ-CRU-5 902 0.02 EQ-CRU-5

An additional output file will be generated by the program after completing each of the
probability run. This file is named as “Filename.Prob-level.record.csv”, such as “USF-2012-m-
CRU.PSPA.P9.EQ-CRU-5.csv 7, Which contains response data (peak and residual values) for the nodes
and elements where time history response has been requested, as per Section 4.3 bullet 2 in this
User Manual. The data are accumulated or appended to the end for each record; the output file
from the last record in the series is used to generate the response hazard curves using the
probabilistic approach (Wu 2017, 2018).

See below an image of the VERSAT-D2D Run window when executing multiple PSPA runs:
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411

Step 1: Get Authorization from Intemet

UserName |OPEN Abort Analysis (waming: don't use x-button
to stop a run)

Password INotRequired No. of VERSAT-D2D runs in processing: 1

T e To-do-in-total: 45

Step 2a. Load csv File for multi-runs: X :

time=2.645 steps=1058 unbalanced force=57.12 gravity force = 14622542
time=2.673 steps=1069 unbalanced force=52.30 gravity force = 146224.89
time=2.703 steps=1081 unbalanced force=43.67 gravity force = 146224.21
time=2.730 steps=1092 unbalanced force=61.77 gravity force = 146223.78
time=2.758 steps=1103 unbalanced force=88.91 gravity force = 146223.72
time=2.788 steps=1115 unbalanced force=100.83 gravity force = 146224.08
time=2.815 steps=1126 unbalanced force=125.66 gravity force = 146224.67
time=2.845 steps=1138 unbalanced force=159.35 gravity force = 146225.36
time=2.873 steps=1149 unbalanced force=113.74 gravity force = 146225.77
time=2.903 steps=1161 unbalanced force=89.08 gravity force = 146225.73
time=2.930 steps=1172 unbalanced force=78.49 gravity force = 146225.26
time=2.960 steps=1184 unbalanced force=46.99 gravity force = 146224.63
time=2.990 steps=1196 unbalanced force=47.11 gravity force = 146224.31
time=3.010 steps=1204 unbalanced force=38.14 gravity force = 146224 .48
time=3.038 steps=1215 unbalanced force=36.70 gravity force = 146224.98
time=3.065 steps=1226 unbalanced force=88.68 gravity force = 14622553

Idata file: C:\2019.11.25\Ex_PSPA-runs\USF_2012_m.dyn

Use ICHANG=3 to Input Soil Strength by Element

The option is invoked by selecting ICHANG=3 in the “General parameter” window in
VERSAT-2D Processor. When this option is selected, the data in the file “Filename.soil-
strength.CSV” are read in by the program. In the current version, only three quantities (Su, crrl5,
Su_lig) in this file are used by the program to replace (supersede) the corresponding quantities
calculated from the material zone parameters. This option is only valid in a dynamic analysis,
i.e., not applicable to a static analysis. The functionality is the same as “Non-linear Effective
Stress Analysis” or ICHANG=2.

This file “Filename.soil-strength.CSV” 1S also an output file when the advanced option of
“ICHANG=3" is not selected; however, the same file becomes an input file when this option is
selected. By this arrangement, the user has the choice of updating the three quantities for the
desired soil elements based on in-situ stresses, which can be read in the file “Filename.OUG”.

Woutec Geotechnical International, Canada (www.wutecgeo.com) .



VERSAT-S2D and VERSAT-D2D Version 2021.06.09: User’s Manual page 43

5

5.1

INTERPRETING RESULTS OF A STATIC ANALYSIS

Output Quantities

Now let’s use “ex_d10” from the library of Examples (Ex_d10_UpperSanFernandoDam) as an
example for Sections 5 and 6.

The main output file from a static analysis carries an extension of “OUT” such as ex_d10.out.
The quantities in the main output file include ‘node disp-x rot. disp-y elem sig-x(mx0) sig-
y(ta) tau-xy(sh.) gamm_xy%(mi) pp su fos sig-m’. The meanings of these quantities are
explained as follows:

node: list of node number in this column;

disp-x: list of displacement in X-direction (incremental if imsh=0; cumulative if imsh=1).
rot.: rotation at this node (applicable for a beam node only);

disp-y: list of displacement in Y-direction;

elem: list of element number in this column;

© ks~ wbhF

sig-x(mx0): effective stress in horizontal (X) direction (ox) for a soil element; If this is a
beam element, mx0 is the bending moment at the centre of the element;

7. sig-y(ta): effective stress in vertical (Y) direction (oy); If this is a beam element, ta is the
axial force in the element;

8. tau-xy(sh.): shear stress in the XQOY plane (txy); If this is a beam element, sh. is the shear
force of the element;

9. gamm_xy(%)(mi): shear strain (in percentage) in XOY plane. If this is a beam element, mi is
the bending moment at the first node of the element;

10. pp: static pore water pressure in the element;
11. su: shear strength of the soil element;
12. fos: factor of safety against a shear failure;

13. sig-m: effective mean normal stress (om).

To present the results using the Processor, nodal displacements are duplicated in an output file
with an extension of “DIS” such as ex_d10.dis, and element quantities are duplicated in an output
file with an extension of “SIG” such as ex_d10.sig.

The geometry output file carries an extension of “OUG ”, such as ex_d10.oug, and contains the
geometry input data including node information (X and Y coordinates, degrees of freedom) and
element information (node composition, element type, material number, and pore water
pressures).
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The stress output file carries an extension of “PR4”, such as ex_d10.pr4, and contains stresses at
every Gauss point of the finite element model including structural elements. The stresses
contained in this file are referred as the pre-existing stresses®. In a subsequent static or dynamic
analysis, this file should be renamed or copied as an input file with an extension of “PRX”.

5.2 Display Results of a Static Analysis Using the Processor

(see Appendix A for a plotting example)

Select FILE and choose LOAD DATA to load an input data file such as ex_d10.sta.
Select SETTING and choose LOAD SETTING to load a problem specific setting file such as
ex_d10.log. This will allow the geometry of the model to be shown properly on screen.

3. Select FILE and choose LOAD OUTPUT to load the output files containing displacements
and stresses such as ex_d10.dis and ex_d10.sig.

4. Select VIEW and choose “MODEL VIEW OPTIONS” to select the type of information you
want to show on screen including node numbers, element numbers, material colors, boundary
conditions, displacements, stresses, and others.

Note: The finite element model for ex_d10.sta is shown in Figure 5.1. More details on showing
results of analyses are provided in Section 6.2.

EX_D10: S3IMULATION OF THE UFFER 3AN FERNANDO DA DURING EARTHOQUARKE OF FEB 19, 1971

Firite element mesh showing element munbers

Resetvoit water level 5

12 [ 621 §1
600 (Bl ] [p123'613
588500 [501 |59z |503 |50

- orshth 570 (571 [372 [373 (374 [575 b7
65 547 [548 |549 [550 [551 [ 552 hag
sy A0 |50 [ 521|522 [523 [sa4 (525 [ 526 52

56 [487 [45% [450 [490 (491 [402 [493 [40% (40540

457 458 [459 460 [461 [462 463 [464 [4635 [466 | 467"

392 3%
o4 | 205 |26 (207 (208 (209 |300 (301 (302 |303 |304 [305 |306 (307 (308 |309 | 310 &11|312 |313 (314 | 315|316 |317 (318 |319 | 320 (321 |322 (323 | 324 325 326 337

0 (230|240 (241 (242|243 | 244 (245 |246 (247 245 | 240|250 (251|252 |253 | 254|255 |256 |25T |253 | 259 [260 (261 (262 |263 | 264 |265 (266 (267 | 263 | 268 | 270 | 271

G2 | 183 [ 154 | 155 | 156 15T | 158 | 185 |190 |191 |192 | 193 |194 |195 |196 |197 [ 198 |199 (200 (201 (202 (203 |204 (205 |20 (207 (208 (209 (210 |211 | 212 [ 213 | 21% | 215

26 | 127 128 129 | 130 [131 [ 132 | 133 [134 | 135 |136 | 137 | 138|130 |140 |141 | 142 |143 | 144 (145 (146 (147 (148 |149 [150 (151 [ 152 [153 [154 |155 | 156 157 158 153

O |71 |72 |73 |74 |73 |MG |FT |TE |79 (B0 |E1 |E2 |83 B4 |B5 (B4 |87 (88 (80 (90 (91 |93 |93 |4 |95 |94 [9F7 [9F |90 100 101 102 103

-1a0 1] IIIJD 200 300
Hotizontal Distance ( Axs - X))

Figure 5.1 Finite element model showing element number and soil zones for ex_d10.sta

% In VERSAT-2D static and dynamic analyses, pre-existing stresses are always obtained from an input file with an extension
of PRX, which contains model stresses computed from a previous static analysis and saved (in an output file with an
extension of PR4) for a subsequent static analysis or for a dynamic analysis. The PRA4 file is then renamed as PRX file.
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INTERPRETING RESULTS OF A DYNAMIC ANALYSIS

Output Quantities

The main output file from a dynamic analysis carries an extension of “OUD” such as
ex_d10b.oud. The quantities in the main output file include ‘node disp-x disp-y acc-x(g) acc-
y(g) elem sig-x(mx0) sig-y(ta) tauxy(sh.) gamm_xy%(mj) PEAKgamm_max(%) vol(%)
ppr(FSliq)’. The meanings of these quantities are explained as follows:

node: list of node number in this column;

disp-x: list of displacement in X-direction (instant at time t; or maximum);

disp-y: list of displacement in Y-direction;

acce-x: list of acceleration in X-direction (instant at time t; or maximum);

acce-y: list of acceleration in Y-direction;

elem: list of element number in this column;

N o ok~ wobd e

sig-x(mx0): effective stress in horizontal (X) direction (ox) for a soil element; If this is a
beam element, mx0 is the bending moment at the centre of the element;

8. sig-y(ta): effective stress in vertical (Y) direction (oy); If this is a beam element, ta is the
axial force in the element;

9. tauxy(sh.): shear stress (including static shear stress) in the XOY plane (txy); If this is a
beam element, sh. is the shear force of the element;

10. gamm_xy%(mj): shear strain (in percentage) in the XOY plane (yxy); If this is a beam
element, mj is not defined,;

11. (a) PEAKgamm_max(%): peak dynamic maximum shear strain of the element up to current
time, ymax = square root [yx? + (ex — &y)?]. Output with group of quantities for “state at the
end of earthquake...”, i.e., 1% set in the PSPA output

(b) DynStressRatio = tauxy_dyn/cvo': the ratio of peak dynamic shear stress (not including
static shear stress) over the initial effective vertical stress, e.g. CSR=0.65+DynStressRatio.
Output with group of quantities for “peak dynamic response between ...”, 2" set in PSPA.

12. vol(%): volumetric strain in percentage (%) caused by dynamic loads;

13. ppr(FSliq): dynamic pore water pressure ratio (PPR) or factor of safety against liquefaction
(FSliq).

To present the results using the Processor, nodal displacements are duplicated in an output file

with an extension of “DIS” such as ex_d10b.dis, and element quantities are duplicated in an

output file with an extension of “SIG” such as ex_d10b.sig.

The geometry output file carries an extension of “OUG ”, such as ex_d10b.oug, and contains the
geometry input data including node information (X and Y coordinates, degrees of freedom) and
element information (node composition, element type, material number, and pore water
pressures).
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6.2 Display Results of a Dynamic Analysis Using the Processor

Select SETTING and choose DYNAMIC ON to turn on dynamic option.
Select FILE and choose LOAD DATA to load an input data file such as ex_d10b.dyn.

Select SETTING and choose LOAD SETTING to load a problem specific setting file such as
ex_d10.log. This will allow the geometry of the model to be shown properly on screen.

4. Select FILE and choose LOAD OUTPUT to load the output files containing displacements
and stresses such as ex_d10b.dis and ex_d10b.sig. It is noted that the Processor can only load
one set of results (displacements, stresses etc) to display. Therefore, the first set of results
must be deleted from a DIS file and a SIG file in order to load the second set of results.

5. Select VIEW and choose “MODEL VIEW OPTIONS” to select the type of information you
want to show on screen including node numbers, element numbers, material colors, boundary
conditions, displacements, stresses, and others.

Notes:
» An example of ground displacements at the end of shaking is shown in Figure 6.1:
Ex_d9 Bridge Crossing with Piles\ dynamic analysis\ex_d9 NicoM_1c.dyn as
input data.

» The data entered in the windows in Figure 6.1, such as “Value range for color”,
can be saved in a setting file. The setting file can be retrieved later. Details on
setting file are provided in Section 2.1.

6.3 Retrieving Time-History Response

The time history data are saved in a file with an extension of CSV, such as ex_d10b.csv. Bullet
5 of Section 4.3 provides details on how to obtain time history data for acceleration and
displacement for nodes, and stress, strain and pore water pressure data for elements.

6.4 Regarding Nodal Response for Outcropping Velocity Option

When the Outcropping Velocity Option is used, absolute values of displacement and acceleration
at all nodes in the finite element model are computed directly by the program, and therefore all
reported quantities (including instant values, maximum values and time history data) on
displacements and accelerations should be interpreted as absolute values®.

4 When the Acceleration Option is used, the reported quantities on displacements and velocities are relative to the model
base.
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Figure 6.1 Display finite element model (material in color) and horizontal displacements (Disp-
X) in color

E

G%Latlon (m) Figure A Bridge Crossing: Finite Element Model
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APPENDIX A: EXAMPLES FOR PLOTTING

displacements
by values or by color

December 8, 2016
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APPENDIX B: VERSAT-2D Model Preparation for Upper San Fernando Dam

(See Volume 1 Technical Manual for Results of Analyses)
March 5, 2017
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ATTACHMENTS:

Procedures for making the finite element model used in the dynamic analysis of
the Upper San Fernando Dam;

Step 0: Sketch on paper for five soil units

[1] Rolled Fill
USF_2017: Dynamic Finite Element Analyses of the Upper San Fernando Dam Using a Finer Mesh

[2] Hydraulic Fill

Reservoir level & phreatic line Zone 7 [1] X23@1.57m & Y7@0.78 m [3] Clay Core
[4] Upper Alluvium
[5] Lower Alluvium

Mat-6 [2]Above water

~140.0-130.0-120.0-110.0-100.0-90.0 -80.0 -70.0 -60.0 -50.0 -40.0 -30.0 -20.0 -100 00 100 200 300 400 500 600 700 800 900 1000 1100 120.0 130.0 140.0 150.0 160

19 February 2017 by Dr. G Wu 1



1. Make finite elements for 3 areas & SORT:
(download VERSAT-2D from: http://www.wutecgeo.com/documents/VERSAT-2D_2016gwu.zip

(1). Start VERSAT-2D Processor by “Accept” terms:

E WERSAT-2D STATIC AND DYNAMIC FINITE ELEMENT ANALYSIS OF CONTINUA
File SETTING DEFINE TOOLS VIEW MODIFY RUM HELP

& 7] O ore Y] | 4 | 3] w (NI 2 |1

Change view option: VIEW => Draw Marker for Node/Elem => Show Marker Only
under SETTING, load “USF_m_1.log” & under File, load data “USF_1_view_only.sta”

(2).
(3).

USF_2017: Dynamic Finite Element Analyses of the Upper San Fernando Dam Using a Finer Mesh

Other Nodes (x, v)

Node 4 (-17 51,366) 5

Node.5 (-3.05,371.46) Zone 7- [1] X23@1.57m & Y7@0.78 m
Node 6 (3.05,371.46) /VNG\

Node 8 (7 61,366) N2 8 "NOIN10(24 4.366) 'N12(50,366)
Node.0 (18,366)

[2] Zones 5,6: X43@3.0 m & Y12@1.0

N13(81,354)

ode.2(-138,354) N3(-48,354) 354)

Node.11(27,349)

[5] Zones 1,2,3: X100@3.0 m & Y20@1.0 m

ode.1(-138,334)

Note: The colored soil units (in previous slide) can be shown by doing the following:
VIEW Model View Options => Show x, y axis; Show Material color

19 February 2017 by Dr. G Wu
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1. Make finite elements for 3 areas & SORT:

(4) Under FiIe, load model data ”USF_l_nodes.sta" Element Distribution

(5). Make Area 1: 100 x 20 by: - 1::91 j:ez
(a).TOOLS => Draw finite element grid => enter: 100, 20, 0 => OK | element
(b) Snap sequentially nodes:

Nodel, N14, N15 and Node2 to create the grids below Element
material no 0

[380.0
USF_2017: Dynamic Finite Element Analyses of the Upper San Fernando Dam Using a Finer Mesh OK ‘ Cancel |
375.0 Other Nodes (x, y)
L Node 4 (-17.51,366) N5 N6
370.0 Node.5 (-3.05,371.46) Zone 7. [1] X23@1.57m & Y7@0.78 m
"Node.6 (3.05,371.46)
=550 Node.8 (7.61,366) N4 N8 NON10(24.4,366) N12(50,366)
: Node.9 (18,366)

360.0 [2] Zones 5.6: X43@3.0 m & Y12@1.0 m
1355.0 - _

NoUS I RE S 1535 IGES TR 15(16:
1350.0 e

=15 | W
1345.0
1] 2Taral “ - k| ra Ol L
| 1 i i, F =
340.0
1335.0
ode 1(-138.534 14(16

330.0
325.0

-140.0-130.0-120.0-110.0-100.0-90.0 -80.0 -70.0 -60.0 -50.0 -40.0 -30.0 -20.0 -10.0 0.0 100 200 300 400 500 600 700 800 900 100.0 110.0 120.0 130.0 140.0 150.0 160.0 170




1. Make finite elements for 3 areas & SORT:
(6). Make Area 2: 43 x 12 by: Element Distribution
TOOLS => Draw finite element grid => enter: 43, 12, 0 ; OK i ;id“ jizdez
Snap sequentially nodes: element
N3, N13, N12 and N4 to create the grids below

Element
material no 0

[380.0
USF_2017: Dynamic Finite Element Analyses of the Upper San Fernando Dam Using a Finer Mesh
575 0 OK | Cancel ‘
Other Nodes (x, v)
| Node 4 (-17 51,366) N5 NG
370.0 Node.5 (-3.05,371.46) Zone 7: [1] X23@1.57m & Y7@0.78 m
Node 6 (3.05,371.46)
9650 Node 8 (7.61,366) P L ol 2(50,366)
Node 9 (18,366) frieeebasiai A b
"""" il il ol ol o
I e e Fik il inf il il il ol
360.0 - e Aol ALy cy ol Bl
[2] Zones 5,6° X43@3 0 m & Y12@1 0 Meairtriririririi i ol ol o ol oo
------------ il il il ol ol el ol B A N W W W N Y N Y
- ey o sl ol ol ol ol ol ol L LN
355.0 — i LB N A A AR i |
._.O'_at (T FoL o) = 3 7 F G T ) 15(16:
ﬁ) 0 o' ol o
g L I ETMN
1345.0
5] =t rat 7 4 =t | o
| T T = i, T i i =3
3400
1335.0
ode. 1(-138,334 14(186:
1330.0
o ‘ ‘ ‘ ‘ ‘ ‘ ‘ ‘ ‘ ‘ ‘ ‘ ‘ ‘ ‘ ‘ ‘

-140.0-130.0-120.0-110.0-100.0-90.0 -80.0 -70.0 -60.0 -50.0 -40.0 -30.0 -20.0 -10.0 0.0 10.0 200 30.0 400 500 60.0 70.0 80.0 950.0 100.0 110.0 120.0 130.0 140.0 150.0 160.0 170



1. Make finite elements for 3 areas & SORT

(7). Make Area 3: 23 x 7 by:

TOOLS => Draw finite element grid => enter: 23, 7, 0; OK

380.0

1375.0

1370.0

1365.0

1360.0

1355.0

1350.0

1345.0

1340.0

1335.0

1330.0

1325.0

Snap sequentially nodes
N4, N9, N6 and N5 to create the grids below

USF_2017: Dynamic Finite Element Analyses of the Upper San Fernando Dam Using a Finer Mesh

Other Nodes (X, v)
Mode 4 (-17.51,366)
Node.5 (-3.05,371.46)

Zone 7: [1] X23@1.57m & Y7@0.78 m

7

Node.6 (3.05,371.46) 5
"Node 8 (7.61,366) P e

x
,
MNode.9(18,366)  _ivttrtiiiios T oo
F

I
o

2(50,366)

LA B L S . L. N
L B W

rLr T ELEER
L NN

[under SETTING, load “USF_upper_dam.log” for a larger view]

Element Distribution
side 1 side 2

No. of 23 7
element

Element
material no 0

3]
1]
N

= L3 A Nl

f } 15(16:

B
I~

E
it

14(16;

-140.0-130.0-120.0-110.0-100.0-90.0 -80.0 -70.0 -60.0 -50.0 -40.0 -30.0 -20.0 -10.0 0.0

10.0 200 300 400 500 60.0 700 80.0 90.0 100.0 110.0 120.0 130.0 140.0 150.0 160.0 170

(8). sort the Mesh under MODIFY => Clear duplicate nodes => Sort nodes (v)/element(h)
(9). Under File =>SAVE Model Data as “USF_2.sta”; so it can be reloaded if needed.



2. Make zone boundaries forming the Clay Core & SORT!

(1). under SETTING, load “USF_upper_dam.log”

(2). under TOOLS => draw a line.. ; snap nodes N7 and N11 to create a line;

(3). again, draw a line from nodes N7 to N8;

(4). again, draw a line from nodes N10 to N11;

(5). sort the Mesh under MODIFY => Clear duplicate nodes => Sort nodes (v)/element(h);
Total 2835 nodes, 2704 elements ;
mesh creation completed!

T SOMNET T T ING TITNRR S SN S A NSO Nede 1962
Zones 5.6 X43@3.0m & Y12@1.0m AT
.............. ST
PN A A A L O T N N N N N N N
______________ A o A O N N Ny
______________ P A O U T T O N N T N N N N N N
______________ A A A A A L W Y N N N N N N N
________ o A A A o0 o N O N N N N N N N N
________ vl il AR A A A o o A i O W N O N N N N N N N N N N N
; A A A S o o VR U N O N N N N N N N N N NN
; VAR A A A A Y W N N N N N N N N N
ode.862 At | . % [ ode.2(023
. ﬁal} - .
E 74 ST E_ Elem476
i
11

(6). under File, SAVE model data to “USF_3 mesh.sta” for future use (if required).



3. Assign soil unit no. for all zones; Define soil parameters, Adjust D/S layer thickness,

Set RUNs (layers, water tables, etc.), boundary, water loads (in RUN4)

(1). under TOOLS => Assign soil zones; snap nodes N7, N11, N10, N8; type 3 (Clay Core)
for the input box; refresh view to see blue zone (shown below)

(2). do the same for all other soil zones

(3). under File, SAVE model data to “USF_4 temp.sta” for recovery, if required.

i N )

pilo) Zone 7: X23@1.57m & Y7@0.78 m
iy
....... i
....... P
........ Faltalls
AT T de. 1962
Zones 5,6: X43@3.0m & Y12@1.0m T S S S TS ara
Py yyrsyasIaNe '/./'/./'/./' BN N S S NSNS
.............. 7
LSS s B0 N N N S SN S NN NN NSNS
______________ ST OV U S SN S N N NN NSNS NS
________ Yekiodosl L L L [ [ [ L N N N N N N N N N N N
S S S ST OV NN S SN N SN N N SN NN NN
S S S S ST L N N N N N N N N N N
'/'/./'/-f/-/[ \\\_\'\\'\_\'\'\\'\\\\'\'\'\\'\'\'\

ode.862 [ ode.2023

Tl U744 Tlams U7eE
™= T T = T T

11




3. Assign soil unit no. for all zones; Define soil parameters, Adjust D/S layer thickness,

Set RUNs (layers, water tables, etc.), boundary, water loads (in RUN4)

(4). do the same for all other soil zones (note: Use No. 6 for hydraulic fill above water)
under SETTING => load “USF_Model.log” and refresh view (with Show Material color on)

[380.0 [1] Rolled Fill
USF_2017: Dynamic Finite Element Analyses of the Upper San Fernando Dam Using a Finer Mesh
. [2] Hydraulic Fill

. [3] Clay Core

[375.0

[370.0 Sy, Zone 7- [1] X23@1.57m & Y7@0.78 m
365.0 . [4] Upper Alluvium
1360 0 [5] Lower Alluvium

L . Mat-6 [2]Above water
365.0

[350.0

[345.0

[340.0

[335.0

(5). Under DEFINE => Input material parameters, as per table below [APPLY ALL]

(use Kg/3 and Kb/3 for static analysis; use the same parameters for No. 2 and No. 6)
Table 1. Soil stiffness and strength parameters of the Upper San Fernando Dam (Seed et al. 1973).

Strength parameters Stiffness parameters®

Soil Unit weight _

unit Soil material (KN/m?) ¢’ (kPa) o () Komax K, Ky

1 Rolled fill 22.0 1245 25 52 1128 2821
2 Hydraulic fill 19.2 0 37 30 651 1630
3 Clay core 19.2 0 37 1 651 1630
4 Upper alluvium 20.3 0 37 40 868 2170
5 Lower alluvium 20.3 0 37 110 2387 6000

*Modulus exponents (m = n = 0.5) were used for all soil units.

19 February 2017 - by Dr.GWu ' - ' -8



3. Assign soil unit no. for all zones; Define soil parameters, Adjust D/S layer thickness,

Set RUNs (layers, water tables, etc.), boundary, water loads (in RUN4)

(6). RUN1: under DEFINE => setup static analysis => Add a layer: 1000 elements; repeat
for 500, 509; APPLY and EXIT SETUP; refresh view with “Show layers by color” ON

Apply No of Elements in a Layer (construction/excavation)

570.0 . TR Zone 7: (11 X23@1.57m & YI@0.78 m no. of elements in layer1= 1000
RUN 1 model: : T, no. of elements in layer2= 500
no. of elements in layer3= 509

70,0 B - Add a layer l Delete a layer '

|||||||||||||||||||||||
K e T |

(7). under DEFINE => setup static analysis => click “NEW RUN” to setup RUN 2, 3, and 4
(see USF_4-FINAL.sta for more details on sequence of static analysis, RUN 1, 2, 3, &4)
(8). re-load setting file: “USF _m_1.log”
Under TOOLS => Assign boundary ...; snap two nodes at the base to assign “fixed”;
also do two side boundaries (“free Y”); refresh view with “Show boundary..” ON

SN EEEEEE
B394] NI==G 394 R ":54'{' NABR{81-354) 15(16:

355.0

EFIIFIEY .Y
ULIG. L1F 1O

350.0

<

o= A
TNULIE 7.

345.0

i
N
o
[i7]
i
q
]
8]
LT

340.0

3350 &g hd4s £ N14(16
19 February 2017 by Dr. G Wu 9



3. Assign soil unit no. for all zones; Define soil parameters, Adjust D/S layer thickness,
Set RUNs (layers, water tables, etc.), boundary, water loads (in RUN4)
(9). In RUN4, apply water loads on the model surface under the reservoir
note: pressure values = 9.81 x water head from reservoir to the surface.
(a). under TOOLS=> Apply distributed load, snaps nodes N2, N3, and enter two pressure
values of “156.0” that normal to the surface;
(b). also for N3, N4 with “156.0” and “39.1” as values;
(c). also for N4, N1078 with “39.1” and “0” as values.
Refresh view with “show load vectors” ON

Node 4 (-17.51,366)
370.0 Node 5 (3.05377.46)
Node.6 (3.05.371.46)
| Node.8 (7.61,366)
365.0 Node.9 (18,366)
!
[2] Zones 5.6 X43@3.0 m & Y12@1.0 m Prrais Farar
et Wl Wl Wl vl Tl P |
| el Wl Wl Wl Wl vl FE A
3550 -l Dy 14 (oMol =dF RN Bl | "’1\ \\ 'I
INUUE L1941 30, 5JHT |“\\'|-‘ lJIq‘J -lia‘ Esési
1 IR WA
350.0 YA
ll!. ]
345.0
340.0
335.0
ode. 1(-138,334)

(10) under File, SAVE model data to “USF_4 FINAL.sta”; ready for RUN



4. Final Check & RUN (run password: “gwu2015”; not required for preparing a model)

(1). Check model RUN3:

re-load setting file: “USF_Model.log” ;
refresh view with “Show layers by color” “Show boundary..”, “Show load vectors”
and “Show water leel” “Show x, y axis” ON

Note: RUN2 only applies the water table (blue line in the figure below) in 4 increments.

[1] Rolled Fil

USF_2017: Dynamic Finite Element Analyses of the Upper San Fernando Dam Using a Finer Mesh

RUN 3

[2] Hydraulic Fill

Zone 7- [1] X23@1.57m & Y7@0.78 m [3] Clay Core

[4] Upper Alluvium

[5] Lower Alluvium

Y

/////// v T }". HEEOOOUYS T3 Mat-6 [2]Above water
=
i 2
S . T
19 February 2017 by Dr. G Wu 11




335.0

USF_2017: Dynamic Finite Element Analyses of the Upper San Fernando Dam Using a Finer Mesh

RESERVOIR LEVEL

RUN 4

Zone 7: [1] X23@1.57m & Y7@0.78 m
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FI IR R
e P AN AT LAV AR KA A
Vo 05 P R SRR R AR,
AT LLIITT AL A AR R R R AR RN
A ST T T PRl R R R o,
XA ST DL RS AN
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4. Final Check && RUN (run password: “gwu2015”; not required for preparing a model)
(2). Check RUN4 (apply new water table in blue and water loads, both in 6 increments)
(3). Check soil parameters under RUN1 (they will be carried forward, unless reassigned!!)

[1] Rolled Fill

[2] Hydraulic Fill
[3] Clay Core

[4] Upper Alluvium
[5] Lower Alluvium

Mat-6 [2]Above water

19 February 2017

(4). Run versat-s2d with 4 RUNs
(a) Enter PW and Connect Now g
(b). Step 2 Select file “USF_4 _FINAL”

(5). results from static analysis ..

Step 1: Get Authorization from Internet

User Name

Password

gwu

Connect Now

Step 2: Select File to Start

by Dr. G Wu

This license expires on: 12/31/2017
12:00:00 AM

Abort Now
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5. Setup the dynamic analysis:

19 February 2017 by Dr. G Wu
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5. Setup the dynamic analysis:
(1). (download VERSAT-2D from: http://www.wutecgeo.com/documents/VERSAT-2D_2016gwu.zip
(2). Start VERSAT-2D Processor by “Accept” terms:

E WERSAT-2D STATIC AND DYNAMIC FINITE ELEMENT ANALYSIS OF CONTINUA
File SETTING DEFINE TOOLS VIEW MODIFY RUM HELP

| 7= 0] or | A | L] w (M )

=g

(3). under SETTING, load “USF_model.log” & under File, load data “USF_4 FINAL.sta”
(4). under SETTING : Dynamic on; click “YES”
(5). under DEFINE : General parameters, click “nonlinear effective stress...”, & new title
(6). under DEFINE : Setup dynamic analysis: (a) enter “2704” under NPRE; and (b) enter
numbers for node/elem time histories (TH). — leave blank if TH not wanted. “APPLY”
(7). Under DEFINE: Input material parameters:

(a). update Kg, Kb with values listed on Table 4 (Slide No. 12),

(b). input PWP parameters in [2] hydraulic fill (using values for No. 2a in Table 4)

(c). APPLY ALL, reload this window and check!

Table 4. Pore-water pressure parameters and residual strengths used in Seed et al. (1976) pore-water pressure model.

Material Equivalent Residual strength

No. Soil description (Nyso CRR o 0 (kPa)* K.LIQ
2a Upstream hydraulic fill 14 0.154 3.0 0.1 23.0 (480) 400
2b Downstream hydraulic fill 14 0.154 3.0 0.1 23.0 (480) 400
2¢ Hydraulic fill in the downstream free field 14 0.154 3.0 0.1 14.4 (300) 400

* Pounds per square feet in parentheses.
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5. Setup the dynamic analysis:
(7). (b). If Wu(2001) PWP is used, then use the values in Table 3 below:

Table 3. Pore-water pressure parameters and residual strengths used in the modified MFS model.

Material Residual Equivalent
No. Soil description C G M strength (kPa)* K.LIQ (Ni)so

2a Upstream hydraulic fill 0.32 1.25 320 23.0 (480) 400 14

2b Downstream hydraulic fill 0.32 1.25 320 23.0 (480) 400 14

2c Hydraulic fill in the downstream free field 0.32 1.25 320 14.4 (300) 400 14

* Pounds per square feet in parentheses.

(8). Get ready to run (create a new folder “Dynamic” for dynamic analysis):
(a). under File, SAVE model data as “USF_Seed.DYN” — input master file to run in (9).
(b). copy “USF 4 FINAL.pr4” to “USF_4 FINAL.PRX” — copy results from static run
(c). manually prepare (using notepad) “USF_4_FINAL ACX” [ioies
(this is already done for you !!) [FACX, ACY (nori, vert base accelerations),

(9). Run versat-d2d (run password: “gwu2015”) [* VEX (hori. outcropping velocity), * FXY (force)
|"_P RX (existing stresses when NPRE=0)

|are to be prepared manually.

|Format same for ACX, ACY, VEX, FXY
UserName  |gwu lLine 1: Title

ILine 2: NPOINT, DT, FAMPL, NRVSUB

Step 1: Get Authorization from Internet

Password
lLine 3: NLINE, NoPerLine
Connect Now ‘ Ig?géi%%ﬂ;fﬂexpires on: 12/31/2017 | data separated by comma (m/s™2, ft/s*2
o | m/s or ft/s (velocity); or kN/m for forces)
Step 2: Select File to Start ‘ Abort Now ‘
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